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1 What's new in this revision

While there are many small changes throughout the text, here are the major changesin
revison 1.3 in no particular order:
- A better “swouter” solution.

Additional APA Architecture

Additional ways to improve APA startup time

chatr commands for HP Itanium Platform

Dealing with "topology islands' in APA

Additional GUI configuration changes

2 Introduction

This document is intended as a handbook to help customers properly deploy the Extended
Topology and APA features of NNM 7.5x.

This document is a collection of "Best Practices’ we have gathered while working with
customers. It isnot meant to be a complete deployment guide but customers and
integrators should find it useful.

This paper assumes you know how to get “classic NNM” (including OVW, netmon,
snmpCollect, etc.) up and running. All emphasis will be on the configuration and
deployment of the more modern features including Extended Topology (ET) and Active
Problem Analyzer (APA). We will also be specifically addressing NNM 7.51. Asof this
writing, thisisthe latest version of NNM. NNM 7.51 released many new features that
are documented via whitepapers. We recommend you to read those as well.

We won't be covering specific technology in APA and ET. We won’t describe the
technical way they work. Some very good presentations have been given on the
technology behind these features at OpenView forums and HP Software Universe. We
can get you a copy of these presentations if you are interested. Thisis more of a
document about deploying and tuning rather than understanding the technol ogy.

3 Conventions

Throughout this paper, we will give commands and files in their UNIX style like
$OV_BIN/ovstop. You can easily make the tranglation for Windows to
%0V _BIN%\ovstop.

4 Acronyms and definitions

NNM = Network Node Manager

ET = Extended Topology

APA = Active Problem Analyzer

NNM Classic = Refersto original NNM topology (netmon discovery, loadhosts,
autodiscovery, netmon polling, etc.)

* NNM SE = SameasNNM Classic. No ET. No APA.

* DIM = Distributed Internet Monitoring



MS = Management Station

CS = Collection Station

MOM = Manager of Managers

OVO = OpenView Operations

ovet_poll = the actual process name for APA

ovas = the NNM Application Server for the User Interface
BES = Binary Event Store

5 Machine Sizing

A common guestion we get asked is, “How much computing power is required for ET
and APA?" We don’'t have aformula but we can give a suggestion for large
environments. What do we consider a“large environment” for one NNM station?
We would say:

* more than 2500 switches and routers

* more than 100,000 interfaces

For alarge environment, we recommend the following but stress that thisis not a
requirement, but just a recommendation.

* 4-CPU box

* CPU speed is very important
— 3GHzCISC
— 1GHzRISC

*  RAM also important
— atleast 2 Gig RAM

Another suggestion, on Windows especiadly, isto not install NNM on the same partition
as the Operating System. If you have a C drive and aD drive, put NNM on the D drive.

6 Database

Most large scale NNM solutions are using the built in database called Solid. You can use
Oracle but it is not required. The NNM solution has more database hints for Solid so
performance should be good on Salid.

When using Solid, we also recommend the following steps. We typically see at least a
10% performance improvement.

* Always move the Solid database off the OS drive
* Use RAID 0 or some other RAID technology for the Solid drive

The final and probably most important step is to follow the guidelinesin the 7.51
whitepaper called Solid Performance Improvement. Not all of the settings in that
document are setup automatically when you install 7.51 so check to make sure they are
al set. The setting ForceThreadsT oSystemScope is specific to Solaris and must be added
manually after a 7.51 installation.



Note: the settings in that paper can be applied to Solid on 7.5 so even if you haven't
installed 7.51, get a copy of the whitepaper and follow the steps by hand.

7 Background on ET

We are now going to assume you aready have an “NNM Classic” topology in place.
This means that you have all your nodes discovered either by auto-discovery, loadhosts,
or added to map and these nodes are monitored by netmon. If you need further
information about setting up classic NNM, see the Managing Y our Networks manual.

Let us give alittle bit of background on what ET does. ET does not discover new nodes.
It discovers the “extended topology”. Thisincludes layer 2 connectivity, HSRP, VRRP,
VLANS, and other information. Thistopology isthen used by APA to monitor the
network. ET does discrete discoveries which tend to last anywhere from 4 hours to a full
day.

What does ET get from classic NNM? Each ET discovery gets alist of managed nodes
and a mapping of MAC addresses to | P addresses for nodes in the NNM topology.
Unmanaged nodes are not brought into ET. But “netmon unmanaged” interfaces are not
respected in APA and may or may not be monitored by APA.

8 Enabling ET

It issimpleto enable ET. Run $OV_BIN/setupExtTopo.ovpl from the command line. It
will ask you some licensing questions. Depending on the size of your network, the script
may prompt you to automatically determine and configure zones. We suggest answering
“Yes’ tothisif prompted.

9 Tuning ET Discovery

9.1 Zones

The concept of zonesis discussed in the ET manual provided by HP
(Using_Extended_Topology.pdf). Please take the time to go read Chapter 2 and
Appendix A in this document before going further in this handbook.

We'll give a simple summary of zones here. “Zones’ is not a network term. Thisisan
NNM ET term. Theway ET discovery works is that as nodes are interrogated, their
information is stored in an “in-memory” database. At the completion of discovery, the
in-memory database is deleted. The final ET topology is stored into Solid database. In
order to make ET discovery more scalable, it uses a divide-and-conquer approach to
segment the network into smaller pieces. Zones are used represent alogical division in
the network. ET will discover each zone separately and then merge the information
together at the end. If anodeisin multiple zones, it will be interrogated in each zone
discovery.

Zones can be created manually by the user or automatically by NNM. There are pluses
and minuses to each approach. We will list some here. We recommend creating manual



zones as we feel these typically lead to afaster discovery with better accuracy in the
connectivity.

9.2 Autozone Tool

Y ou can have NNM create zones for you. These zones are strictly based on Layer 3
information from the classic NNM topology. The advantage to using thistool is that you
don’t have to think about it much. The disadvantage isthat it can create less than ideal
zones and break up key node connectivity. A lot of that is because on many networks,
the | P address of a switch doesn’t imply alot of information about the layer 2
connectivity. A second disadvantage to using autozone is that it must be re-run before
each discovery if you have added new nodes since the previous discovery. Most
customers don't realize this. Since autozone is very specific about putting nodes into
zones, if you add additional equipment since the last run of autozone, the new equipment
will be put into the “default zone”. That’s usualy a poor place for nodesto go. And if
you are not careful, you' [l end up with too many nodes in the default zone. The third
disadvantage to the autozone tool is that it tends to put more nodes than necessary into
multiple zones thus causing slower discoveries.

Autozone can be run from the User Interface or from the command line. To run it from
the User Interface, go to the “Extended Topology Configuration” page and click on
“Configure Zones Automatically”.

invent

Extended Topology Configuration ?(ﬁa

YWhen finished, press "Apply" to put any changes into effect.

Zone: Members

Default Zone

[JExciude nodes that are not part of any zone from discovery.

[ Delete Zone H Discover Zone ] [ Configure Zones Automatically | [ Test All Zones

2one Administration:
Define a new zone, or click in the list above to select one to edit.

Mermbers:

{example: 15.3.82.%; 10.2.3.4-9; *.hp.com }

Add Mew Zone ] [ Add To Zone ] [ Replace Zone

[Apply ] [ Cancel ] [ Reset ]

To run it from the command line, simply execute $OV_BIN/autozone.ovpl. No
arguments are required. In both cases, the log file $OV_PRIV_L OG/autozone.log is



generated. Thislog fileiswritten during the autozone execution so you can “tail” the file
if you wish to monitor progress. The autozone tool can take along time to execute.

Y ou might consider setting up autozone.ovpl to run as acron job or scheduled task so
that it executes before running an ET discovery. If you do this, you should restart the
ovas process after running autozone.ovpl.

ovstop ovas
ovstart ovas

The ovas process is the GUI Application Server for NNM. You need to restart it after
running autozone.ovpl viacommand line because the GUI doesn’t re-read the autozone
results when autozone.ovpl is run from the command line. If you don’t restart ovas, it
can cause some issues showing accurate progress in the Discovery Status bar and the Test
All Zones button. So if you run autozone.ovpl via command line, restart ovas as well.
Thisis not true for when you click the “ Configure Zones Automatically” button. When
you autozone this way, the GUI is aware of the change and adjusts accordingly.

There is one additional change you can make with autozone but use this one very
cautiously. If you have avery powerful computer, you might consider allowing more
nodes and interfaces to go into asingle zone. Thereisafile called
$OV_CONF/nnmet/recVas.conf. Inthisfile, thereis ONLY ONE VALUE that you
should ever change. That isthe numManagedObjects value. DO NOT change the
numManagedNodes file. DO NOT change any of the other values either. The only value
you can consider changing is the numManagedObjects. This number represents the
maximum number of objects that are put into asingle zone. If you have a very high end
computer, you might consider increasing this value to 10000. We don’t recommend
going higher than that. After you change this value, you can re-run autozone.ovpl or
rerun it viathe GUI.

# Not e: nunmMvanagedoj ects (below) refers to the nmaxi mum nunber of

# managed nodes + nmmnaged interfaces that can be handl ed safely in a

# single zone. It is calculated when setupExt Topo.ovpl is run, based

# upon systemresources of the managenment station. The val ue here can

# be adjusted. Note that it will be recalculated and overwitten the

# next tinme setupExtTopo.ovpl is run. Note that meking the nunber too

# large will result in the Automatically Configure Zones option in the

# Extended Topol ogy Configuration QU creating |arger zones, which may

# be too large for a systemto handl e or degrade performance. The

# creation of fewer, large zones may be easier than many snaller zones.

# Maki ng the nunber too small will require nore zones, and will nean that

# zone creation (either by hand or autonmtic) nmay take |onger and involve nore
# decisions about splitting a switch fabric into different overlapping zones.
# This nunber is also used by the "Test Al Zones" button to generate

# war ni ngs when a configured zone or candi date zone exceeds this size.
numvanagedObj ect s: 6000

9.3 Manual Zones

As mentioned earlier, thisis our preferred method. But it’s only redlistic to use this
method if you adhere to a naming scheme that includes location information or if you can



separate your geographies based on IP ranges. Let us explain more about zones and then
we'll cover how to create them but again, thisis covered more thoroughly in the Using
Extended Topology Manual.

Anideal zoneisabunch of equipment that is connected via Layer 2 and Layer 3 and
“stands alone” meaning it contains all the Layer 2 gear that is directly connected. At
most customer sites, the best mapping of azoneisabuilding. Many customers “route”
between buildings. Y ou should separate zones at layer 3 boundaries. Y ou also should
connect up the zones by having at least one router from each zone in another zone.

Y ou should not separate the following equipment into different zones:
1. Directly connected switches
2. Switches connected to routers
3. Switchesin the same VLAN (that is, having the same global VLAN names or
IDs)

An example from the ET manual is shown here. In this sample there are three zones.
Zone 2 and Zone 3 would typically be abuilding. Notice how this example has one
router from Zone 2 and 3 that isalso in Zone 1. We know thisis very simplistic but it
should help you understand the concepts.

Zonel __ Routers

Router

\"-. S witches

\ Servers f Cs ! '-\ Servers PCs .-f
/

A \ /4

Zone 2 Zone 3

Now let us show an approach to specifying these zones. Many customers use a naming
convention to specify location and also device role. Maybe the naming convention is



WWxXYyYyzzz where ww is city, xx is building number, yy is device type like switch or
router and zzz is device role like core, distribution or access. So as an example, let’s say
you have two locations, Fort Collins (FC) and Loveland (LV). Let’s also suppose we
support afew device types like Switch (SW), Router (RT), Server (SV), Firewall (FW),
and Load Balancers (LB). Of course thelist could go on and on. And last, let’s suppose
you have some roles like Core (COR), Distribution (DIS), and Access (ACC).

With this information, we could decide that we want to build the zones using the
following expression. Let me assume that the router in zone 2 and 3 above that is shared
between zones is identified as a distribution router.

FCO1* (thiswill be zone 2 in the picture above)
FCO02* (thiswill be zone 3 in the picture above)
FC?2?7?DIS, *COR (thiswill be zone 1 in the picture above)

The good news is that manual zones support limited pattern matching expressions. It's
not afull regular expression, so do some experimenting with it before you go too far.
Here is the usage sheet on the pattern matching. Notice the use of the NOT “!” in the
brackets and also notice that you can match a“-". A common mistake happens with the
asterisk. The asterisk only matches up to the first period. So in my example above,
FCO1* would match FCO1SWACC but not FCO1SWACC.corp.com. Y ou might need to
make the wildcard show FCO1*.corp.com instead.

NOTE: We do some validation of the wildcarding in the GUI when you hit Add New
Zone, Add To Zone, and Replace Zone. Sometimes the GUI is more restrictive than
really necessary. If you feel brave, you could try editing the XML file directly asthat isa
little more lax on the wildcarding rules.

Character Usage

Use an asterisk to represent any number of characters up to the next period:

_ * . COr p. COMmatches PC. COr p. COMor WS. COY p. COM
Asterisk . pc.*.commatches pC. cor p. comor pc. | ocat i on. com

* . * matches COr p. COMor PC. COM but not PC. COr p. COM The * in
10. *. 1. 3 matches any number.

Use to match a single character:

Question + pcC. c?. commatches pc. ca. com pc. cb. com or pc. cC. com but does
mark not match pc. cal . comor pc. c. com

? pc. ???. commatches pc. abc. com pc. bcd. com or pc. cde. com but
does not match pc. ab. comor pc. abcd. com

Brackets Use to match single characters, characters within a range, or characters not within a
[..] range:
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[ bcf] an. cor p. commatches ban. cor p. com can. cor p. com or
fan. cor p. com but does not match dan. cor p. comor | an. cor p. com

[ b-d] an. cor p. commatches ban. cor p. com can. cor p. com or
dan. cor p. com but does not match f an. cor p. com an. cor p. com or
cl an. copr.com

[!'d-2z] an. cor p. comrestricts the selection to aan. cor p. com
ban. cor p. com or can. cor p. com

Specify a range of IP addresses.

Dash
n-n - 10.2.1-3.1represents 10.2.1.1,10.2.2.1,0r10.2.3. 1

If you prefer to edit XML directly, you can edit the file $OV_CONF/nnmet/etconfig.xml.
Make sure you create a backup before editing the file. Also note that the GUI server
(ovas) does not know if you have edited the file by hand. In order to see the changes, you
need to restart ovas. Thereis no command line for testing zones so you must restart ovas
and test the zones via the GUI.

Let me give afinal recommendation about working with manual zones. | suggest that
you try discovering a couple of zones that are fairly representative of the network. Here's
away to do that. Make abackup copy of $OV_CONF/nnmet/etconfig.xml. Then use the
ET Configuration page to delete all but a couple of zones. Next be sure to select the
checkbox “Exclude nodes that are not part of any zone from discovery”. Because we
deleted most of the zones, the majority of nodes will be in the default zone. By checking
this box, it tells ET to only discover nodes that are in the few defined zones.

% Exclude nodes that are not part of any zone from discovery,

Delete Zone ] [ Discover Zone ] [ Configure Zones Automatically

Zong bdminicteatinn:.

Get afeel for how each time each zone takes. Then you can project this across the entire
discovery. Thereis additional time at the end of alarge discovery but thiswill at least let
you have a sense of how fast your zones will go. Ignore this backend time while doing
this experiment and just focus on the time per zone.

When you are finished, you should replace the backup etconfig.xml file. Then restart
ovas.

9.4 Testing All Zones

After configuring the zones either via manual or autozone, you should run the Test All
Zones button.

11



Extended Topology Configuration d () |
-
invent
When finished, press "Apply’ to put any changes into effect.
Zone: Members
Default Zone
2: fo2™
30 fec??e?DIS " COR;
[JExclude nodes that are not part of any zone from discovery,
[ Delete Zone ][ Discover Zone ][ Configure Zones Automatically H Test All Zones D\\i
Zone Administration:
Define a new zone, or click in the list above to select one to edit.
Mermbers: |fod1%;
(example: 15.3.62.%; 10.2.3.4-9; *.hp.com }
Add Mew Zone ] [ Add To Zone ] [ Replace Zone
Aply

Look over your results. Your goal isto have the Additional Information say N/A for
each row. You aso probably don’t want anything in the default zone though you might
be using this zone as a catch-all. If so, make sure it adheres to the guidelines we listed

above.

12



‘2 Extended Topology Zone Configuration Test - Microsoft Internet Explorer |Z||§|rg|
s

Extended Topology Zone Configuration Test
Analysis started . Analysis complete.

Complete results, including zone contents, can be found in the
file: /var/opt/0V/tmp/etzonetest.out

Zone Contents

Zone Node Count (Managed
Modes + Managed Additional Information
Number
Interfaces)
1
2 I3

6 (479) M/
22 (383) 7
3 63 (1867) M/ A

Modes in this zone did not match any of the
Default 1 (54) zone specifications and will not be connected to
nodes in other zones,

Multi-zone nodes: 26
NNM Nodes Not Exported to Extended Topology

Reason Node Count {Managed Nodes
+ Managed Interfaces)
0

Entries
in feto/opt/OV/share/conf/nnmet/bridge.noDiscover:

Unrmanaged in NNM databases: i]

Close

b

Y ou should also look at the log file /var/opt/OV /tmp/etzonetest.out that is generated. In
that file you'll find a nice listing of the nodes in each zone.

We recommend that you re-test your zones occasionally to make sure nodes aren’t
inadvertently falling into the default zone.

9.5 Running ET Discovery

Now you are ready to run adiscovery. You can either do this through the ET
Configuration GUI or by running the command:

$OV_BI N etrestart.ovpl —verbose —di sco

| like the —verbose option though it is not required. Y ou can monitor the progress of the
discovery viathe Discovery Status page. You can also tail thefile
$OV_PRIV_LOG/ovet_disco.log.

9.6 Incremental Node Discovery

Incremental Node Discovery is one of the new features released in NNM 7.51. This
feature allows the users to have “Incremental node discovery” in ET. As of NNM 7.50,
only netmon (classic NNM) was able to discovery the nodes dynamically. In ET, it was

13



not possible to add the single node dynamically and discover it. ET always required
full/zona ET (batched) discovery to incorporate newly added/managed nodes in NNM.
With Incremental Node Discovery coming in NNM 7.51, users will have the benefits of
managing the newly added nodesin ET and they will aso have the capability to monitor
these newly added ET nodes via APA. However, there are few limitations to Incremental
Node Discovery. For example, anode added in ET via Incremental Node Discovery isthe
representation of classic NNM topology node. Since netmon (classic NNM) is not able to
discover VLAN, HSRP and etc specific interface information; Incremental Node
Discovery will not have the VLAN, HSRP interfaces discovered and monitored as well.
Nor will these nodes have any addresses beyond the management address. Thereis no
(L2/L3) connectivity information calculated if the node is added in ET via lncremental
Node Discovery. All such nodes are seen as island nodes in Dynamic views. All the
interfaces of such nodes are aso “Unconnected” interfaces. Incremental Node
Discovery can be enabled by adding the “-single_node_discovery” option in the
$OV_CONF/ovet_bridge.lrf file.

With all these limitations, you may be asking, “Why should | use this feature?” The main
reason is to be able to monitor these nodes more quickly viaAPA. We present alot of
details about APA in other sections in this document. The APA behavior for polling new
incremental nodes is defined by the isNewNode and isNewlnterface polling policies
(paConfig.xml) until anew ET discovery is run at which point these nodes are no longer
considered “new”. Many customersliketo at least “ping” these new nodes just to make
sure that they are alive until the next discovery.

9.7 Cisco Discovery Configuration

A new feature that was released in 7.51 is Cisco Discovery Configuration. Thisfeatureis
strictly for reducing your ET discovery time though it could also improve your
connectivity if doneright. Thereisagood whitepaper about this functionality, namely
$OV_DOC/WhitePapers/CiscoDiscoveryConfiguration.pdf. Please read through this
whitepaper as we won't duplicate the information here. 1f you run CDP in your network,
we strongly suggest that you try disabling Forwarding Database Tables (FDB) on
strategic devices. You need to be careful with this feature but it can be powerful. If you
disable FDB, then you rely on CDP for connectivity. Obviously you won't discover
connectivity to non-CDP devices from Cisco devices. For example, if you have Cisco
switch connected to a Windows Server, you won't discover the connection to the server.
(Assumption here is that the server is monitored by NNM.) So you may not want to use
this feature on certain switches connected to servers. But you might want to go with
“pure CDP” discovery on your Wireless Access Points as servers typically won't be
connected to them.

Do some thinking about this and try out some experiments. We' ve seen substantial
improvement in discovery times with this feature. But you must be careful to not
accidentally lose important connections. We recommend that between experiments, you
should track the number of layer 2 connection to make sure you aren’t losing alot.

14



To check this, click on the Discovery Statustab. Then click on View Topology

Discovery Progress

100%

Discoverny status as of 3:45:028 PM Oct 7, 2005: Discoveny complete.

Alert: Interface Renumbering has occurred on node mplsce? . cnd.hp.com in zone 0. Please initiate rediscowveny of zone
Time last dizscoweny completed: 5:20:09 PM Sep 13, 2005,

1 zones configured.

i Wiew Topalogy Summan.rrl} Extended Topalogy Configuration
L

|Dﬁ,rnami|: Wiews ready

Then look for the section listing “Number of L2 Links’. Make sure that number doesn’t
drop unexpectedly low. But note that sometimes it drops for legitimate reasons due to
improved discovery accuracy. Y ou should aso launch a Neighbor View on nodes of the
type you'’ ve been modifying and see how the connectivity looks.

Fxtended Topology

fetwork Node Manager Extended Topology Information:

State: Topology State = READY
Last Discovery Completed (Cache Timestamp): Sep 13, 2006 5:20:09 P
Length of last discovery cycle: 13 Minutes, 4 Seconds
Murnber of Licensed Mode Limit : Unlimited
Murnber of Modes: 70

o IPW4 Nodes: 70 {(100%)

< IPVE Modes: O

< Doesn't respond to SHMP: 4 (6%0)

& MNumber of Interfaces: 1789
< IPW4 Interfaces: 1789 (100%)
o IPVGE Interfaces: O

Murnber of L2 Links: 124 %
Murnber of YLAMNS: 26
Murnber of HSRP Routing Groups: 3
Murmber of WRRP Routing Groups: 0
Mumber of Meshes: 15
Murnber of IPVE PrefixGroups: O
Murnber of IPW4 Subnets: 111
Murnber of Aggregate Ports: 12
Murnber of Boards: 51
Average Mumber of Interfaces/Mode; 25.56
Murnber of Addresses: 371

< IPW4 Addresses: 371 (100%)

< IPWE Addresses: O
# Total Mumber of Topology Objects: 2385
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9.8 Interface Filtering

Another feature that was introduced as part of 7.51 is Interface Filtering. Again thereisa
whitepaper describing this feature in $OV_DOC/WhitePaperd/| nterfacekiltering.pdf.

This feature was primarily introduced to deal with routers that have a huge number of
virtual interfaces that you don’t care to manage. Some customers have routers with over
10,000 virtua interfaces. Devicesthislarge can be very challenging for ET. With this
feature, you can eliminate many interfaces that you don’t care about.

We have aso found this feature to be useful to speed up discovery by eliminating blocks
of interfaces you never intend to monitor. For example, you might want to only monitor
the uplink on your Wireless Access Points. With this feature, you could identify your
WAPs by a naming convention and then eliminate all interfaces except those with an IF
Name of “Gi*” or aspecific IF type. You can find alot of information about interfaces
by opening the Node Details page of anode. From here you can easily see the Name,
Description and Alias of an interface. For more details, click on the Entity Name link for
an interface.

Node Details for ntc6k04
General Capahilities Addresses Interfaces Boards WLANS Layer 2
Total Number of Interfaces: 22
Interfaces
Entity Name Name Description alias Status Index Board Port DNS Name Address

ntcokod.cnd.hoygomnl 01 Gild1 GigabitEthernetl/l  |LACP Port-Channel 1 to ntcékgwl Gig2/3 | @ Harmal 1 1 1

ntcokod.cnd.ho.coml O 2 GiliZ GigabitEthernetl/2  |LACP Port-Channel 1 to ntc6kow2 gig3/3 @ rormal 2 1 2

ntcokod.cnd.ho.coml 0 3 Gizdl GigabitEthernetz/1  |LACP Port-Channel 1 to ntcékgw2 Gig2/3 | @ marmal 3 2 1

ntcokod.cnd.ho.com[ 0 4 Gizdz GigabitEthernetz/2  |LACP Port-Channel 1 to ntcékgwl Gig3/3 | @ marmal 4 2 2

ntcokod.cnd.ho.coml O[5 Gizd3 GigabitEthernet2/3 |- G Mot Monitored |5 2 3

ntcokod.cnd.ho.coml 0 6 Gizdd GigabitEthernet2/4 |- G Mot Monitored |6 2 4

ntcek0d.cnd.hp.com[ 0 7 Giz/5 GigabitEthernet2/5 |- ot Manitared |7 z El

beclOd cnd b Lololl i ioabitCib O

From the Interface Details page, you can see the value for IF type. You can find the IF
type definitions at http://www.iana.org/assignments/ianaiftype-mib or you can also see
this MIB on your installation under $OV_SNMP_MIBS/Standard/IANAIifType-MIB.
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Interface Details for ntc6k04.cnd.hp.com[ 0 [ 12 ] ]

General Capabilities Addresses HERP

General

ntc6k04.cnd.hp.com[ 0 [ 12 ] ]

Status: D Normal

Description: EOBCO/0

Extended Topology ID: 79deacf0-3d13-71db-0bae-0f0278ed0000
Interface Last Updated: Sep 13, 2006 5:17:59 PM

Interface Created: Sep 13, 2006 5:17:59 FM

Interface Name: EQ0/0

Interface Alias: -

Interface Index: 12

Port Number: 0

Yendor Port Number: 0

Interface Speed: 100 MBits/sec

Interface Physical Address: 00:00:21:00:00:00
Interface Administration Status: up

Interface Operational Status: Up

At one customer site, we were able to eliminate al the ports on User Access switches
(not server switches) except for uplinks. This eliminated 100,000 interfaces and
significantly improved the discovery speed. If you can get the interface count down,
you'll be able to potentially combine zones together, possibly improving your
connectivity accuracy. You'll aso see the entire system speed up by simply removing
the volume of interfaces that NNM has to deal with. Another nice benefit of thisis that
your APA poller will have faster start up times.

NOTE: We have noticed one side-effect that you need to be aware of. When you
eliminate huge number of interfaces viathis feature, they will not be discovered as part of
ET but they may have aready been discovered as part of classic NNM (netmon). After
you setup the netmon.interfaceNoDiscover file, netmon will begin removing interfaces
from the classic topology when a*“config-poll” is performed on anode. Thereis usualy
a high overhead when removing huge numbers of interfaces (like 100,000). Expect to see
some processes running high CPU like ovwdb and netmon for the next 24 hours after
making this change. When running this high, it makes ET discovery slow down. So
you'll need to strike a balance between testing your improvementsin ET and waiting for
netmon to demand-poll all the nodes. It is recommended to shut off netmon during the
ET interface filtering experimenting. After you get al the interfaces that you wanted to
discover, re-enable netmon and let it run 24 hours.
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10 Tuning APA

Now that you' ve finished your discovery, your next step is probably to enable the APA
poller. Ironically, we are going to now suggest that you might want to tune APA with a
smaller topology. It'll make for faster turnarounds when you are tuning. Y ou might
consider going back to just one or two zones as mentioned previously for making the
APA work while tuning. But eventually you'll need to tune APA against the entire
topology.

We won't be going into the technology behind APA in this paper but we'll point out a
few things here. APA only workson ET objects. It performs state-of-the-art polling and
root cause analysis. Much of its analysisis based on “neighbor analysis’. That’s why
it’s important to get agood ET discovery. APA is extremely flexible and can be tuned to
do amost anything. But this flexibility introduces complexity.

Y ou can go with the out-of-the-box settings but in general, you' |l get better results by
doing some tuning. It'snot trivial and you'll need to get comfortable editing XML. But
if you are willing to get your hands dirty, your network management will be that much
better.

10.1 APA and Netmon

APA replaced the netmon status polling. Netmon continues to run even when APA is
enabled. Netmon continues to do regular “configuration polling” and auto-discovery of
new nodes if you have it configured thisway. So you will see both processes running
simultaneously. But after you enable APA, it does all the status polling.

Most important to note is that none of the netmon status polling configuration carries
over to APA. If you had previously marked many interfaces as unmanaged for netmon
(viaeither the OVW GUI or using the ovautoifmgr tool, none of these changes will apply
to APA.

Y ou must configure and tune APA using a separate, new approach as described in the
next few sections.

10.2 APA Architecture

APA is not designed to work with traditional NNM distribution (Distributed Internet
Monitoring or DIM) involving a Management Station (M S) and multiple Collection
Stations (CS). That is because the ET database is not replicated.
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10.2.1 Collapsing Stations

Because APA can scale to larger numbers than netmon was able to, some customers have
had success “ collapsing” multiple collection stations into asingle NNM station. Thisis

shown here:
%@5 ”%@

NNM Station NNM Station
running ET running ET
and APA and APA

SN
IS

Collection Station Collection Station

running netmon running netmon
Network B

This picture shows a High Availability (H/A) clustering solution being used for failover
like HP Service Guard. If you don’t require failover, you could just use a single station
and do regular backups. If a station then fails, you could restore your latest backup and
continue monitoring from there.

Network A & B

If you choose this approach, be sure to run some initial tests. At one customer site, we
found that the numbers from the old netmon stations were alittle misleading. Because
the customer had limited their discovery with netmon options, not all of the interfaces
were being discovered and monitored. When we ran “ovtopodump —I”, it showed alow
interface count on the collection stations. But when we discovered the same network
with NNM 7.5, it had a much higher interface count because al the L2 interfaces were
now being discovered. This made us realize we couldn’t collapse as many collection
stations together as we had initially hoped.
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10.2.2 Using OVO as the Manager of Managers (MOM)

If you decide to go with separate ET stations for monitoring portions of your network,
you can collect all thealarms at atop level OV O stations. You'll need to launch to
specific HomeBase instances for each ET station for dynamic views like Neighbor View.

o)

] ]
(= =
10.2.3 Using NNM MS with netmon and NNM CS with APA

Some customers have tried using the failover capabilities of DIM by using netmon at the
MS level and APA at the CSlevel. We recommend against this solution because APA
and netmon model status differently and are configured differently. You will end up with
inconsistencies. You aso will end up with more alarms than expected. It's amost
impossible to make netmon and APA poll in the exact same way.

Y ou could use this setup if you didn’t need failover and just want a centra management
station similar to the OV O solution described above.

Collection Station Collection Station
running APA running APA
and ET and ET

20



10.2.4 Using two NNM stations in a “warm standby” scenario

Some customers have had success using two NNM stations acting as a pair to
simultaneously monitor the same network in order to have failover. Usually the alarms
are forwarded to a central station. In this setup, when one machine fails, the redundant
machine is configured by the user to forward events to the central station only during the
failover period.

In this setup, each NNM station is running its own independent ET discovery and APA.
Thereis no formal synchronization between the stations. Only the configuration files are
kept in synch. This can be done via a shared drive or by deploying all configuration files
to the NNM stations from a central location. There aren’t many configuration files (4 or
5files) to keep in synch so this can be afairly easy task. Thereissomerisk that that the
ET databases maybe different between the primary NNM station and the redundant
station but thisrisk is quite low if ET discovery is done near the same time and that any
ACL’s adlow the same node access. Of course, traps must be sent to both stations in the
pairing.

/ .
Cs}ntral Statiol
;for alarms

N
Only forward
when active
\\
N
N

N
N
N

!
Only forward
when active

NNM Station

. Redundant Station NNM Station Redundant Station
running APA running APA running APA running APA
and ET and ET and ET and ET

10.3 Enabling APA

With your architecture in place, the next step isto enable APA. Sometimes we call this,
“throwing the big switch.” By default, APA monitors only HSRP and OAD
(Overlapping Address Domain) devices. To make APA poll all nodes, you need to enable
APA (Throw aBig Switch). When you enable APA, netmon will no longer be doing
status polling. That is now the job of APA. The netmon poller will continue to do new-
node discovery if have run auto-discovery and it will do configuration polls on nodes.
APA aso does an abbreviated form of a configuration poll but it does not full replace the
netmon version.
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To throw the big switch, run

$OV_BI N ovet _apaConfig. ovpl —enabl e APAPol | i ng

This command automatically configures netmon to no longer perform status polls. Be
prepared for a high number of adarms. APA polls things differently than netmon and
you'll see new alarms. APA will send alarms on nodes that netmon has already alarmed
you about. After some time, it will get to a steady-state. We'll get these alarms under
control via tuning but you will see a high number at the beginning. You could put in
place some the suggested tuning steps before throwing the big switch but we usually just
enable APA and then start working from there.

You'll also see alarms about addresses for the first time. APA models interfaces and
addresses separately whereas netmon treated addresses as an attribute of an interface.
The APA modé is more accurate. Y ou can have an interface reporting as “up” via
SNMP status and yet not be reachable via ICMP (ping).

The basic APA Model is a parent->child relationship with top most entity as a Node.
Model is:

Node (Node contains boards/cards)

Board (Board contains interfaces) [if Boards/cards are not present on the device,

interfaces are children of nodes|

0 Interface (Interface contains address(es))
§ Address (Lowest leve entity)

Status propagation for different objects happens like:
Node 3 Board I3 Interface (3 Address
Different Statuses marked by APA are:

Unknown (Blue), Minor (Y ellow), Critical (Red), Normal (Green) and Disabled (Brown -
only for interfaces which are having ifAdminStatus as “Down” during the ET discovery).

Flags set by APA are:

Not Monitored (for interfaces/nodes)
Responding, Not Responding, Unreachable (for addresses)

Default behaviour of APA:
On detecting afailure, root cause (primary failure) of afailure is marked as Critica

(Red). Parents, if any, are marked as Minor (Y ellow). Children, if any, are marked
as Unknown (Blue) to indicate secondary failure.
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For example, if an address is not responding using ICMP/Ping, address is marked as
“Not Responding”; the interface (Parent) which is associated with addressis
marked as Minor (Y elow); Board, if any, (Parent of an interface) will be marked as
Minor (Y ellow); Node (Parent of a board if the board exists Or parent of an
interface if no boards exists) will also be marked Minor (Y ellow).

For example, if an interface goes down (ifOperStatus=down, in case of linkDown,
marked as Critical/Red); addresses (Children) are marked as Unknown (Blue);
Board (if any) and Node are marked as Minor (Y ellow) being the parents of
interfaces.

Disabled and NotMonitored statuses are not propagated to top/parent level at all.

In case of a Node Down (Node stops responding to SNMP and ICMP/ Node is shut
down/ Power cable of anodeis pulled out), it is marked as Critical (Red) and all the
underlying boards, interfaces and addresses are marked as Unknown (Blue) to
indicate the secondary failure.

In case, where amain IP address of a node does not respond to SNMP (but responds
to ICMP/ping), then the Node is marked Critical with an event in the Alarm

browser saying “SNMP Agent is not responding”. In this case, al the underlying
interfaces of the node will be marked “Unknown”.

In case, where the node partially responds to SNMP for few interfaces (including
main IP address interface), but it does not respond to SNMP (due to an SNMP
timeout) for other interfaces then, the responding interfaces are “Normal”, the not
responding interfaces (the timed out ones) are marked “Unknown” and the Node
turns “Minor” ! Thisis because there is something genuinely wrong with the node
as few interfaces timed out on SNMP query.

In case of a primary/secondary failure scenario, where if router A goes down and
we are not able to reach any nodes behind router A, all these unreachable nodes are
marked as Unknown (Blue) to indicate the secondary failure. Root cause of this
problem will have an event associated with it and the entity (Node/Interface) will be
marked Critical/Red with parents being marked as Y ellow (Minor).
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10.4 Measuring APA performance

Y ou can see how well APA is performing by going to HomeBase and clicking on the
Polling/Analysis Summary page. Y ou typically want to watch the Waiting Poller Tasks
and Waiting Analyzer Tasks. Y ou want these to be near zero though they can be as high
as 100 without areal problem. They will be artificially high when you first start
ovet_poll so let it have alittle time to get caught up. If the numbers are staying high,

then APA isfaling behind in polling and analysis. Y ou can do two thingsto help
improve this. The first, and most important, is to change polling policies to reducing the
amount of polling and analysis required. Thisis described in the upcoming sections. The
second thing you can do is to increase the number of threads for polling and analysis.
Again that is described ahead.

Network Node Manager Home Base

You are currently running with a termporary license that expires on Dec 12, 2006 9:1
the systern administrator run $0V_BIN/ovnnmPassword on the server system, ksm

Wiew

Statistic Current I ax

Active Analyzer Tashis o o
Wraiting Poller Taszhs 1 1
Interfaces Polled (SHMP) 060032 060032
Addreszes Polled (ICMP) 2715 2715
Boards Polled (SHMP) 1444 1444

HERP Groups Polled 266 266

Waiting Analyzer Tashs a % a

|Dynamic WViews ready

10.5 Concepts of Tuning

APA behavior can be changed. APA works with collections of objects. These objects
can be nodes, interfaces, addresses, HSRP groups, and others. Collections of objects are
defined viafilters and some inherent attributes assigned by ET discovery. For instance,
you might have a collection of Cisco Switchesthat is defined by their System Object ID
value. You could also have a collection of al interfaces that are on arouter and have an
associated address within a specific range. Collections can be very smple or very
complex.

These collections of objects then have polling policies associated with them. If an object

passes multiple filters, an ordering is applied such that only one polling policy is assigned
to the object.
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To change APA, you can change existing filters and you can aso define new filters. You
can also define the associated polling policies. The three main parameters on polling
policies include interval, snmpEnable and pingEnable.

The principle files that you will work with include

$OV_CONF/ nnnet / paConfi g. xm

$OV_CONF/ nnnet / t opol ogy/filter/ TopoFilters. xnl
$OV_CONF/ nnnet / t opol ogy/ fil ter/ APANoPol | Nodes. xm
$OV_CONF/ nnnet / t opol ogy/filter/ MyHost I D. xm

/ opt/ OV/ bi n/ ovet _t opodunp. ovpl

[ opt / OV/ support/ NM checkpol | cfg

/ opt / OV/ bi n/ ovet _demandpol | . ovpl

The main files are paConfig.xml and TopoFilters.xml. TopoFiltersxml iswhere the
filters are defined. paConfig.xml is where the associated polling policies are defined. The
other two xml files are support files that are referenced at times. ovet_topodump.ovpl,
ovet_demandpoll.ovpl and checkpollcfg are tools that will be used as part of the tuning
process.

There are two XSD schema definition files that you might wish to read through but these

should not be modified.
+ $OV_CONF/ nnnet/topol ogy/filter/ TopoFilter.xsd
+  $OV_CONF/ nnnet/topol ogy/filter/ TopoFilterCormonTypeDef. xsd

To tune APA effectively, you need to understand both filters and polling policies. | have
a separate section devoted to filtersin ET. Y ou may wish to read the section before
proceeding here.

25



The usual tuning steps include:

|dentify problem or area of concern

Find matching filter or create a new one in TopoFilters.xml

Adjust polling behavior in paConfig.xml

Validate XML edits

Confirm polling settings with various tools including checkpollcfg,

ovet_demandpoll.ovpl, and the APA process itself (ovet_poll).

* Restart APA (ovet_poll) though this may need to be done before the previous step
depending on which tool you are using. The checkpollcfg tool does not require a
restart of APA.

10.6 The simple way out

If you aren’t interested in learning the details of tuning APA, let me suggest afew
common solutions that generally work well for most customers. Y ou could decide to just
go with these.

1. If you have Switch/Routers (we like to call them swouters) like Cisco 6500 and
you run these primarily as a switch, then follow the instructions the Appendix of
this document. NOTE: Thisis anew and improved version of the swouter
document. This has changed from the previous document so ook over the
changes. The changes are not mandatory but provide alittle more flexibility.

2. Usethe predefined class specifications that are commented out in paConfig.xml.
Simply edit paConfig.xml and follow the instructions that are in the file near each
of these class specifications.

a. unmanage interfaces of atype that you know you don’t want to manage
(class specification is called 1f TypeFilter)

b. Disable ping for ranges of addresses that you know are unreachable (class
specification is called NoPingAddresses)

3. Make the changes to improve APA startup time detailed in Section titled
Improving APA startup time.

Y ou could skip over the rest of this APA section if that’s all you want to do.

10.7 Understanding APA polling policy matching

Figuring out why APA is polling something in the way it is can be alittle tricky. Polling
policies are labeled as Class Specifications in the paConfig.xml file.

The three primary “parameters’ that are user configurable are snmpEnable, pingEnable,
and interval. The values for sompEnable and pingEnable are either true or false. The
values for interval are any positive integer greater than zero.

For each object (like an address, interface or node), APA begins parsing the
paConfig.xml from the top down looking for a polling policy match for the object and the
parameter setting. It aso looks for match for its parent objects and applies logic to make
adecision about how to poll the object. For snmpEnable and pingEnable parameters, this
isalogical AND. For interval, its more of an if/else statement as detail below.
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If it can’'t find an explicit policy match for the object, it reverts to the default setting.
Note that default settings are “typeless’, meaning there isn’t a separate default for nodes,
interfaces and addresses. They all share the same default settings. It then does the same
algorithm for the parent object and performs alogical AND of al the results.

In APA, Node is the parent of Interface which is the parent of Address.
Node (3 Interface 3 Address

So if you are trying to find a polling policy for an address in paConfig.xml, it will look
for explicit polling policies for the address, the parent interface and the parent node. It
would look something like this:

(Address Setting) AND (Interface Setting) AND (Node Setting)
where each setting may either be explicit or default.

Let me walk you through an example. Supposed we have an address 10.1.1.1 that is
assigned to an unconnected interface on arouter and we are trying to see whether it is
pinged or not. APA begins looking through the paConfig.xml file for a policy match for
the address. Let’s suppose it doesn’'t find one. So it reverts to the default setting which is
PingEnable=true. Now it goes to the parent object which is an interface. It now parsed
the paConfig.xml file again from the top down looking for a match on the interface. It
now finds a match for “unconnected interfaces on routers’ and the configuration is set to
PingEnable=false. Now it goes to the parent object whichisanode. Again it parses
from the top down looking for amatch. It finds one for routers and the configuration is
set to PingEnable=true. Now we AND all these values together and you'll get:

True AND False AND True = False
Thisisn’t as hard as it may appear at first but it comesin handy to understand it.

The other thing we need to cover just dightly is when the parameter isan “interval”. It's
similar logic but rather than ANDing the values together, it just takes the first value it
matches and doesn’t try the default until al parents are exhausted. So thelogic is:

(Explicit Addr Interval) else (Explicit Intf Interval) else (Explicit Node Interval) else (default interval)

Let’s do another simple example here. |f you had set Routers to have a polling interval of
2 minutes and hadn’t set any polling interval for any Interfaces and hadn’t set any

interval for addresses. Let’s also suppose the default polling cycle is set to 5 minutes.
Then it would evaluate to 2 minutes as shown here:

(undefined) else (undefined) else (120 seconds) else (300 seconds) = 120 seconds
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10.8 How does APA “poll”

APA can gather status either perform an SNMP poll that reads status from a MIB or by
issuing an ICMP poll (usualy called “ping”) and basing status on the response of the
address. We will explore tuning both of these types of polls. If pingEnable and
snmpEnable both are false for a particular object, that object is marked as “Not
Monitored”.

There are also limitations based on the object type. While we speak of pinging a node or
setting pingEnable=true on a node, that’ s really the parent object. The ping is actually
performed against an address that is on ainterface that ison anode. Similar logic is
applied to SNMP polling.

10.9 Out of the box defaults

Before you make changes to APA, it’s good to understand the out-of-the-box settings.
The best way to do thisis to study the paConfig.xml file. The following list issimplified
and not comprehensive but gives a good starting point.

Device Type SNMP|[Ping
PollinglPolling

Default g g
Router - -
Switch g

End Node .

Connected Admin Up Switch IF .
Connected Admin Up Router IF . g

Unconnected Admin Up Router IF | .
Unconnected Admin Up Switch IF
Unconnected End Node o

10.10 What if a node is both a switch and a router?

If anode is both a switch and arouter, then APA pollsit asarouter. That isdueto the
fact that isRouter is above isSwitch in the paConfig.xml file.

Based on the previous table, you can see that would mean that a switch/router is both
SNMP polled and Pinged out-of-the-box. It also means that Connected and Unconnected
Admin UP interfaces would be both SNMP polled and pinged. If you are using these
devices more like a switch, you might not like getting an alarm every time a computer is
shutoff at the end of the day on a user access port.

Y ou could change the polling policies on routers to only poll connected admin up

interfaces on routers (and also change the node level) but that might not be ideal as you
might think of switch/routers differently that pure routers.
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We suggest making a new category called “swouters’ and defining polling policies on
nodes, interfaces and addresses for swouters. See Appendix A — A new and improved
Swouter for complete details on this solution.

10.11 Some HP supplied policies

HP included some commented out Class Specifications in paConfig.xml. These include
APANOoPolINodes
WanlF
IfTypeFilter
AllCards
NoPingAddresses
This list may not be complete. See the paConfig.xml file for the complete list. We found
that these were common policies that customers might want to use yet they usualy
require some modification by individual customers.

To use these policies, smply edit paConfig.xml and follow the instructions that are in the
file near each of these class specifications. Full instructions are included as part of the
comments in the file. We'll use the IfTypeFilter in the next example.

10.12 A quick lesson on reading the Class Specification (polling
policy) in paConfig.xml

Let us show you a snippet of XML from the paConfig.xml file that defines a polling
policy. You can see that there are three parameters namely interval, snmpEnable and
pingEnable. These are set to 300, true and true respectively. Y ou should only modify
these values. But on some polling policies, all three of these may not be present.
Remember in a previous section we described how a setting may be explicit or may
revert to the default. Each of these would be an explicit setting. 1f you setup or modify a
policy and it doesn’t have an explicit setting, feel free to add one. Just copy it from this
snippet.

<cl assSpeci fication>
<filterName>i sRouter</filterName>

<par anet er Li st >
<par anet er >
<nanme>i nt er val </ name>
<title>Interval to Poll Device</title>
<descri ption>The interval which the device will be polled in
seconds. </ descri pti on>
<var Val ue>
<var Type>Il nt eger </ var Type>
<val ue>300</ val ue>
</ var Val ue>
</ par anet er >

<par anet er >
<nanme>snnpEnabl e</ name>
<title>Enable polling via SNWP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via SNVP. </description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t rue</ val ue>
</ var Val ue>
</ par anet er >
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<par anet er >
<nane>pi ngEnabl e</ name>
<title>Enable polling via |CMP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via | CVP. </description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t rue</ val ue>
</ var Val ue>
</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>
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10.13 Example using User Configurable Filters

L et us guide you through a simple example. The valuesin this example are not practical
but it's agood sample. Let’s suppose that you have a number of nodes that are in what
you perceive asa“normal” state yet dynamic views are showing them as non-normal
(yellow). You would like APA to consider the node as normal. The way to achieve this
isto identify what is making it non-normal and modify the polling policies to change this
state.

(e

File Edit View Performance Configuration Fault Tools Help

Naode or Interface: IcZIGfaEIEI all.feay a D Include End Nodes | Refresh )
“Graph

A
&\ 74000

hipdk 23w

=
Filruin
4000

cizcoBa09

Total: 10 Critical: O Minor: Normal: Mot Monitored: Unknown: O

|Dynamic Wiene ready

In this example, you can see the yellow node we are interested in c2k3fa00. Launch the
Node Details page by double clicking on the node. Y ou can see that one of the interfaces
has a status of Minor.
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A Node c2k3fa00 Details - Microsoft Internet Explorer provided by Hewlett-Packard

© Flle Edt Wew Favorites Tools Help Links @]@hpEmp\oyeePorta\ |y Homebase | 5) Sharepaints ;','
O - [ B @n O search T Favorites 2 L RN 3

¢ Address [ ] http: fksmithus.cnd.hp.com: 7510/topology/topoDetai?uuid=960abesa-23d2-7 1 da- 0561 -0F0272a50000 = =

i Google - w| |Gl search - ggh PageRank AEC chek - S0 mubolink v [ options 4

Node Details for c2k3fa00

General Capshilities Addresses Interfaces YLANS Layer 2

« Name: pimMib - Yalue: Str: ~
e Name: mcMib - Yalue: Str:IPMROUTE-MIB

Interfaces

Total Number of Interfaces: 7

Interfaces
Entity Name Name Description alias Status Index Board Port DNS Name Address

c2kafa00.all feov[ 01 Et0/0  Ethernetds0 Connect to hp4kisw port HL D rormal 1 - i} 1Pvd: 15.2.131.63
czk3fa0l.allfeov[ 0 2 Sed/0  Seriald/0 Caonnect to cisco2ks Serialdsd Q Minor 2 - o IPwd: 172.18.0.2
c2k3fa00.all feov[ 0 3 Et1/0  [Ethernstl/0 Connect to hsrp800t port 1 D rormal 3 - 1} IPvd: 15.2,132.3
c2kafan.all foov[ 0 4 Et1/1 Ethernetl/1 Connect HSRP to ciscodkd Ethernetz | @ mMormal “ - 1) 1Pwd: 15.2.129.2
czk3fa0l.allfeov[ 0[S Etl/2  Ethernetl/2 - O Not Monitored |5 - o

czkafa0nallfeov[ 0l 6 Et1/3 Ethernetl/3 - O Mot Monitorsd |6 - 0

c2k3fann.allfoov[ 0711 Mud  Nullo - B normal 7 - 0

Y ou can drill down further down further by clicking on the interface hyperlink.

Interface Name: Se0/0

Interface Alias: Connect to cisco2ks Serialo/0

Interface Type: 32 [%

Interface Index: 2

Port Number: 0

¥endor Port Number: 0

Interface Speed: ? MBits/sec

Interface Administration Status: up

Interface Operational Status: Up
Capabilities

e sCDP
& isFrameRelay

Addresses
IP Level: IPv4
IPv4 Address: 172,15.0.2
IPv4 Ping State: not responding
IPv4 Address Information

Address 1P ¥Yersion Type Ping State
172.18.0.2 IPwd - not responding

Y ou can see that this address is not responding to ping. You have afew choices now.
Y ou could use the NoPingAddresses class specification in paConfig.xml (this also

requires modifying the TopoFilters.xml file as per the instructionsin the file). But let’'s

say instead that you notice that this interface is of type 32. Y ou decide that you never

want to ping any address on an interface of type 32 in your environment. Y ou decide to
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use the HP supplied IfTypeFilter section in paConfig.xml to disable ping of any address
on an interface of type 32.

Y ou should now edit the paConfig.xml file. Find the section on IfTypeFilter. Read the
instructions in the top part of the comment. It tells you to uncomment this section. It
also states that this class specification disables ICMP. Notice that there isn’'t an explicit
setting for snmpEnable. You could add one if you want or just let it use the default as
this would do.

<l-- Uncoment this class specification to disable |ICVWP (ping)
for I FTypeFilter. Users should edit the TopoFilters. xni
file to specify what |FTypes to include in the filter
<cl assSpeci fication>
<filterName> |fTypeFilter </filterNane>
<par anet er Li st >
<par anet er >
<name> pi ngEnabl e </ name>
<title> Enable polling via |CWP</title>
<descri pti on>

Enabl e/ Di sabl e polling of a device via | CVP

</ descri ption> Remove the bottom line

<var Val ue> of text and add --> at the
<var Type> Bool </var Type> top to close the comment
<val ue> fal se </val ue> on top

</ var Val ue>
</ par anet er >

</ par anet er Li st >
</ cl assSpeci fi cati on>
remove this line also to uncoment above cl ass specification -->

The new text should look as shown here.

I-- Uncomment this class specification to disable | CVP (ping)
for I FTypeFilter. Users should edit the TopoFilters. xni
file to specify what |FTypes to include in the filter. -->
<cl assSpeci fication>
<filterName>lfTypeFilter</filterName>

<par anet er Li st >
<par anet er >
<nane>pi ngEnabl e</ name>
<title>Enable polling via |CMP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via | CVWP. </description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>f al se</val ue>
</ var Val ue>
</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>

Now the next step, as per the instructions, isto edit TopoFilters.xml and specify the
IfType that you want. Edit the file $OV_CONF/nnmet/topol ogy/filer/TopoFilters.xml
and search for IfTypeFilter.

<l-- Users can nodify this filter to include |FTypes to filter on
The filter is setup to match interfaces with particular |FTypes
Types can be added to the filter by adding a new attribute with
a particular |Ftype. -->
<interfaceAssertion name="I1fTypeFilter" title="1fTypeFilter" description="Interface are
of a particular ifType">
<oper at or oper="0OR">
<attribute>
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<i f Type>28</if Type>
</attribute>

<attribute>
<i f Type>20</if Type>
</attribute>
</ oper at or >
</interfaceAssertion>

Notice that the comment gives further instruction. It happensto be currently set to IF
types of 28 and 20. These are just placeholders. They weren't hurting anything previous
to enabling the policy in paConfig.xml. Now that the policy is live, we must set the IF
type values properly in TopoFiltersxml. You can see that it is performing an OR of the
ifType 28 and 20. For our example, we want to change thisto ifType 32. Since thereis
an OR condition, it requires two vaues but we only want one (32). So, we two choices.
We could either change the operator from OR to NOOP (meaning No Operation) and
eliminate one of the attributes or you could also just put 32 in for both if Type values. It
won't hurt any and makes it easier to add more interfaces. We'll choose the former as
that’s a little cleaner.

Here' sthe new XML:

<l-- Users can nodify this filter to include | FTypes to filter on
The filter is setup to match interfaces with particular |FTypes
Types can be added to the filter by adding a new attribute with
a particular |Ftype. -->
<interfaceAssertion name="|fTypeFilter" title="1fTypeFilter" description="Interface are
of a particular ifType">
<oper at or oper =" NOOP" >
<attribute>
<i f Type>32</if Type>
</attribute>
</ oper at or >
</interfaceAssertion>

Y ou now should test your changes. First, we recommend that you validate the XML
checking for syntax errors. One easy way to do thisiswith Internet Explorer. All you
need to do is load the files (TopoFilters.xml and paConfig.xml) into Internet Explorer and
it will notify you of any syntax errors. In case you haven’t used this, you can open local
files by using File->Open and then Browse to alocal copy of thefiles. Y ou could also
use an XML editor to validate the syntax.

If thereis an error, you'll usually see an error message like:



2 F:\Documents\TopoFilters.xml

File Edit Wiew Favorites Tools  Help

2 . i
1 1 5 ) e . ~
<, </ x ,yf (1l | -~ Search < ¢ Favorites {7

: hddress @F:'l,Documents'l,TopoFiIters.xml

The XML page cannot be displayed

Cannot view =ML input using X5L style sheet. Please correct the error
and then click the Refresh button, or try again later.

A name was started with an invalid character. Error
processing resource ‘file:f f fF:fDocuments fTopoFilters.xml’.
Line 206, ...

<ifTypex3z2</ifTypes

~

R

If there are no errors, you'll simply see the file without any error messages.

-2 F:\Documents\TopoFilters. xml

© File Edit View Favorites Tools Help

. — n
1 1 Y ) = i ) - - b
) > o ,y: nl | Search 7. Favorites ? =1 W i 3 ._\“

| Address @F:'l,Documents'l,TopoFiIters.xml

=7eml version="1.0" encoding="UTF-8" 7=
<l-- edited with EXMLSPY +5 rel. 4 U (http://www.xmlspy.com) by Paul Frice (Col:
- «filters xmins="http://www.hp.com/openview/NetworkTopology /TopologyFilter" zmins:
instance" xsi:schemalocation="http:/ /www.hp.com/openview/NetworkTopology /Top
- =filter name="AdminDownRouterIF" objectType="Interface" title="Admin Down Router Ir
has an IF Admin Status of down">
- <operator oper="AND">
<filterMame=InterfacelnRouter</filterkameaz
<filterMame=AdminDownInterface«/filterMame:
</operatorz %
</filters
- <filter name="isSwouter" ohbjectType="Node" title="isSwouter" description="Nodes which
- <operator oper="AND">
<filterMame=isRouter</filtertamez
<filterMame=isSwitch</filterMame:

</operators
AR A

The next step isto test the change. Since we made a change in TopoFilters.xml, we'll
test that first. We'll use the tool $OV_BIN/ovet_topodump.ovpl. Thistool hasaman

page.

First run “ovet _t opodunp. ovpl —Ifilt” tolist thefilters. If you corrupted thefilein
some way, this command will fail. Then look for the IfTypeFilter filter just to make sure
it's there.

Next try out the filter. Run “ovet _t opodunp. ovpl —if —filt IfTypeFilter” togeta
list of al the interfaces that match this filter. Make sure that the list matches your
expectations.

Now let’ stest that the polling policies have been applied correctly. Asyou recall, we set
it to not ping any addresses on interfaces of type 32. Aswith most things, there are
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multiple ways to test the polling policy application. Thefirst oneisto use the tool
/opt/OV/support/NM/checkpollcfg. WARNING: Thistool can take a very long time to
execute if you have alarge database. At some sites, it can take 20 or 30 minutes to run.

We don’t think there is a man page but you can give the tool a*“-?’ option for a usage
page. We just usethe “-0” option along with a node name that you want to check. This
tool will print a summary of how interfaces and addresses are being polled based on the
latest version of paConfig.xml and TopoFiltersxml. It’'simportant to notice that this tool
runs independent of the poller process ovet_poll. The poller can be stopped during this
effort. It'sfineif you leave the poller running as well but know that the changes to
paConfig.xml and TopoFilters.xml are not picked up by the poller until you restart it.

Let’s run the command now:

[ opt/ OVI support/ NM checkpol I cfg -0 c2k3fa00

node| ifNane| Board| address I ndexNum polllnterval isPolled pollD sabled snnp? ping?
c2k3fa00.al |l . fcov - 300 1 0 1 1
15.2.129.2 - 300 1 0 0 1
Connect to hp4klsw port H1 I F [ 1] 300 1 0 1 1
15.2.131.63 - 300 1 0 0 1
Connect to hsrp800t port 1 I F [ 3] 300 1 0 1 1
15.2.132.3 - 300 1 0 0 1
Connect HSRP to cisco4k3 I F [ 4] 300 1 0 1 1
15.2.129.2 - 300 1 0 0 1
Connect to cisco2k5 Serial 0/0 I F [ 2] 300 1 0 1 0
172.18.0.2 - 300 0 0 0 0
- IF [ 5] 21600 0 0 0 0
IF [ 6] 21600 0 0 0 0
IF [ 7] 300 1 0 1 1

Let me explain alittle about this output. First, notice that the “node” and its management
address are listed as the first two lines. These indicate the polling policies set on the node
level. Then we list the interfaces on the node. These are not in any particular order so
watch out for that. Notice that the address on an interface is listed as a separate line below
the interface.

The poll interval is given in seconds. The other columns are mostly Boolean values. The
“isPolled” value is simply an AND of the SNMP and ping columns.

Getting back to our example now, you can see that ping values on our interface are 0 and
thus we won't ping the address on that interface.

At this point, we'll restart the poller.
ovstop —c ovet_pol |
ovstart —c ovet_poll

Y ou should now wait for the poller to finish loading everything and begin polling. If you

have a large database, this can take awhile. Y ou can see when it transitions by running
ovstatus and checking the Last Message to read “Polling Devices’.
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ovstatus —c ovet_poll

Nare PID State Last Message(s)
ovet _pol | 2926 RUNN NG (ovet _pol | -81) Polling Devices.

After the poller has begun polling devices, return to the GUI and check the status of the
node. It may still be yellow. Y ou might need to run a APA demand poll on the node. To
do this, right click on the node and select APA Status Poll. The status of the node should
now be up-to-date. In our example, the node should turn green.

Teals  Help

Mode of Interface; [c2k2fall.all.foow 1 Hops ' 3 include End Nodes -r—

c2kdfail

(]

i 1
4000

Double click on the node to launch the Node Details page. Y ou should see that the
interface is now Normal.
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E AED|

Links E:] @hp Employee Portal [ 7) Homebase [ Sharepoints o
H 2 & Search Favorites 42 A LT i, 3
fdress ] hitpefksmithisz. cnd.hp.com: 7510jtopology [topoDetalzulid=960abeta-23d2-71 da-0581 -0F027 250000 v B
Google - v [C] search - g PageRank ARG check S LookForMap v [d options

Node Details for c2k3fa00

General Capahbilities Addresses Interfaces WLANS Layer 2

Interfaces ”~

Total Number of Interfaces: 7

Interfaces
Entity Name Name Description Alias Status Index |Board Port |DNS Name Address

c2k3fan0.allfeow[ O 1 Et0/0  |Ethernetd/0 Connect ta hpdklsw port H1 @ Hormal 1 a IPw4: 15.2.131.63
c2lk3fa00.allfeov[ O] 2 Sel/0  |Seriald/0 Connect to ciscoZks Serial0/0 D rormal 2 a IPvd; 172.18.0.2
c2k3fan0.allfeov[ O 3 Etl/0  |Ethernetl/0 Connect to hsrp800t port 1 D Hormal % 3 a IPwd: 15.2.132.3
c2k3fa00.all foov[ O [ 4 Et1/1  |[Ethernetl/l Connect HSRP to ciscodk3 Ethernetz | @ Normal 4 a IPvd; 15.2.129.2
czkafan0.allfeov[ 0] 5 Et1/2  |Ethernetl/2 - O Mot Monitored |5 o

c2kfa0lallfoov[ 00611 Et1/3 | Ethernetlss |- O Mot Monitared & 0

cekafant.allfeov[ 00711 [Nu0 |Nullo - @ rormal 7 0

If you go down the Addresses section of this page, you'll see that the address is no longer
monitored.

IPv4 Address Information

Address IP Version Type Ping State
15.2.132.5 IPwe - responding
17z.18.0.2 IPve - not ronitored %
15.2.129.2 IPvd - responding
15.2.151.63 IPwe - responding

We used to suggest using the interval value to help diagnose polling settings. |
recommend against that now. Instead use the new feature “-d” option in
ovet_demandpoll.ovpl.

10.14 A new valuable addition to ovet_demandpoll.ovpl

A valuable feature has been added to ovet_demandpoll.ovpl. If you use the —d option, it
will give you al kinds of important information. Feedback has been added about what
polling policy / filter is applied to the current object. Let’s go through an example here.

Begin by running the command ovet_demandpoll.ovpl with a—d option. We are only
showing a snippet of the output here showing an address 10.28.16.33. Y ou see the three
polling policies namely snmpEnable, pingEnable and interval. Y ou can see the
inheritance of the policies. The*“Composite” line shows the reason for the composite
value rather than afilter. If you look closely at the shmpEnable portion, you can see that
it will be always false for addresses. That’s because we never SNMP poll an address, we
only ping addresses.

Y ou can see on pingEnable that the compositeisfalse dueto the ET_FILTER (really a
polling policy) My_Unmonitored_VLAN_Interfaces having a value of false.
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With this output, you'll be able to tell exactly why any object is being polled the way it is.

ovet _demandpol | . ovpl -d testnode. corp.com

ADDRESS 10. 28. 16. 33

OBJ_TYPE SHORT_OBJECT_NAME  snmpEnabl e ET_FI LTER

all -types * true DEFAULT

NODE hp3sw3 true isSwitch

| NTERFACE hp3sw3[ 0[ 53] ] fal se My_Unroni t ored_VLAN I nterfaces
ADDRESS  10.28.16.33 true DEFAULT

Conposite 10.28. 16. 33 fal se Al ways false for Addresses

OBJ_TYPE SHORT_OBJECT_NAME  pi ngEnabl e ET_FI LTER

all -types * true DEFAULT

NODE hp3sw3 true isSwitch

| NTERFACE hp3sw3[ 0[ 53] ] fal se My_Unnoni t ored_VLAN | nterfaces
ADDRESS  10.28.16.33 true DEFAULT

Conposite 10.28. 16. 33 fal se NodeVal && InterfaceVal && AddressVal

OBJ_TYPE SHORT_OBJECT_NAME interval  ET_FILTER

all -types * 900 DEFAULT

NODE hp3sw3 900 isSwitch

| NTERFACE hp3sw3[ 0[ 53] ] 300 Unconnect edAdm nUpOr Test Swi t chl F
Conposi te hp3sw3[ 0[ 53] ] 300 Interface Val ue

Special note to windows users on ovet_demandpoll.ovpl: This perl script calls an
executable called /opt/OV/support/NM/ovet_demandpoll.exe. Dueto theway thisis
structured, you usually can't redirect “ standard out” from the perl script. In order to fix
this, simply copy the ovet_demandpoll.exe into the $OV_BIN directory and then run
ovet_demandpoll.exe instead of ovet_demandpoll.ovpl. The arguments are identical.

10.15 Another suggested polling policy

APA will poll all interfaces on routers by default. Y ou may not wish to poll ISDN
interfaces on your routers. We suggest using the IFType policy shown previously to
disable polling of ISDN interfaces.

10.16 Example of changing polling policies for specific node

types

In this example we'll skim over afew details that you learned in the previous example.
Let’s say you have a class of nodes that you don’t ever want to ping. Y ou can identify
these nodes by their System OID. For this example, we'll use Blue Coat Systems
devices. To modify the polling policy for these devices, you'll need to do the following:

» Edit TopoFilters.xml

— Add node filter based on sysOID

— Add interface filter defining interface on that type of node
* Edit paConfig.xml
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— Add class specification for the nodes based on these filters and define
polling parameters

— Add aclass specification for interfaces on these nodes and define polling
parameters

Let me give afew details. First edit TopoFilters.xml and add the node filter:

<nodeAssertion nane="isBlueCoat" title="isBlueCoat" description="BlueCoat devices">
<oper at or oper ="NOOP" >
<attribute>
<sysO D>1.3.6.1.4.1.3417. 1. 1. 23</sysO D>
</attribute>
</ oper at or >
</ nodeAssertion>

Next add an interface assertion filter to match all interfaces on these nodes. These can be
a little more challenging so we highlighted some important parts.

<interfaceAssertion name="|FI nBlueCoat" title="I|FInBlueCoat" description="Interfaces in
Bl ueCoat devices">
<oper at or oper ="NOOP" >
<interfaceAssoci ati on ascType="i nNode" >i sBl ueCoat </ i nt er f aceAssoci ati on>
</ oper at or >
</interfaceAssertion>

Y ou should now test the filter with ovet_topodump.ovpl. Next you need to put in a
polling policy into paConfig.xml. Y ou must put in a policy for the node and then a
separate one for the interfaces on the node. Remember that thisfileis parsed from the
top down so you need to be careful where you place this policy. We like to place new
policies fairly high in the file so other matches don’t take precedence. Shown hereisthe
node specification. (We left out parts of the XML that are represented with an elipsis

<cl assSpeci fication>
<filterName>i sBl ueCoat </filterName>
<par anet er Li st >
<par anet er >
<nanme>snnpEnabl e</ name>

<val ue>t rue</ val ue>
</ par anet er >

<par anet er >
<nane>pi ngEnabl e</ name>

<val ue>f al se</ val ue>

</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>

Next put in the interface specification.
<cl assSpeci fication>
<filterName>| Fl nBl ueCoat </filterName>
<par anet er Li st >
<par anet er >
<nanme>snnpEnabl e</ name>

<val ue>true</val ue>
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</ par anet er >

<par anet er >
<nane>pi ngEnabl e</ name>

<val ue>f al se</ val ue>

</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>

After making these changes, verify their correctness and restart APA. Now you have a
polling policy in place for these type of nodes and interfaces on these nodes. Now try
running “ovet_demandpoll.ovpl —d <node>" to seeif this node and its interfaces are
being managed via this new polling policy.

While these examples are fairly simple, | think you get the idea of how to make more
complex modifications.

10.17 Improving APA startup time

(Note: These changes have already been done automatically if you have installed the
latest patches, so double check the current definition before changing it.)

10.17.1 First Improvement

This change involves changing the logic for the NotConnectedI F filter. This can make a
huge difference in startup time.

Edit 3OV_CONF/nnmet/topol ogy/filter/TopoFilters.xml
Locate the definition for NotConnectedl F and comment it out.

<l--
<filter nanme="Not Connectedl F' object Type="Interface"
title="Not Connectedl nterfaces" description="Interfaces
wi t hout Layer 2 Connection">
<oper at or oper ="NOT">
<filterName>Connectedl F</filterName>
</ oper at or >
</[filter>

Then find the definition for Connectedl F and place the following new interface
assertion above it (in blue below). You can use the existing ConnectedlF as a
sample but don't forget to change the oper to NOT.

<l-- This is the new one -->
<interfaceAsserti on name="Not Connectedl F* title="Connectedlnterfaces"
description="Interface wi thout L2 Connection">
<oper at or oper ="NOT">
<attribute>
<capabi | i t y>i sL2Connect ed</ capabi l i ty>
</attribute>
</ oper at or >
</interfaceAssertion>

<l-- This one stays the sane -->
<interfaceAsserti on name="Connectedl F* title="Connectedlnterfaces"
description="Interface with L2 Connection">
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<oper at or oper ="NOOP" >
<attribute>
<capabi | i t y>i sL2Connect ed</ capabi l i ty>
</attribute>
</ oper at or >
</interfaceAssertion>

Run ovet_topodump.ovpl -Ifilt to make sure you didn't make any mistakes.

10.17.2 Second Improvement

Edit $OV_CONF/nnmet/topol ogy/filter/TopoFilters.xml
Locate the definition for AdminUpOr Testl nter face
Remove or comment out the exiting definition

<l--
<interfaceAssertion name="Adm nUpOr TestInterface" title="Adm nUpOr TestInterface"
description="Interface with adninistrative state up or testing">
<oper at or oper="OR"'>
<attribute>
<i f Adm nSt at e>up</i f Admi nSt at e>
</attribute>
<attribute>
<i f Adm nSt at e>t esti ng</i f Adm nSt at e>
</attribute>
</ oper at or >
</interfaceAssertion>
>

Add the definition as shown below

<interfaceAssertion name="Adm nUpOr Test I nterface" title="Adm nUpOr TestInterface"
description="Interface with adnministrative state up or testing">
<oper at or oper ="NOT">
<attribute>
<i f Adm nSt at e>down</ i f Adni nSt at e>
</attribute>
</ oper at or >
</interfaceAssertion>

10.17.3 Third Improvement

HP shipped afilter that is slow and should be removed and replaced with simply pinging
all switches. Here are the steps that you should follow.

» Backup original paConfig.xml

* Edit paConfig.xml

* Comment out |FInNotConnectedSwitch filter <!-- -->

» Change isSwitch ping setting to true (pingEnable=true)

» Change UnconnectedAdminUpOr TestSwitchl F ping setting to true
(pingEnable=true)

* Confirm new settings with checkpollcfg (switch address is pinged)

* restart ovet_poll

10.18 Changing the thread count in APA

If you see polling or analysis getting behind and you’ ve done your best to reduce the
number of polled objects with the techniques described previously, then you might try
increasing the number of threads for polling and analysis. Be cautious when increasing
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these values. It will use more system resources. We've had good luck by doubling the
sizes but we know of customers that have gone even larger. The values don’t need to be
amultiple of 2.

To change the number of threads, edit paConfig.xml and look for the sections shown
below. Increase the values and restart APA. We recommend trying 32 for
PollingEngineThreadPool Size and 20 for statusAnalyzerThreadPool Size.

<par anet er >
<nane>Pol | i ngEngi neThr eadPool Si ze</ nane>
<title>Pol |ling Engine Thread Pool Size</title>
<descri pti on>Thi s paraneter specifies how many threads are in the polling engine
thread pool. Increasing the value of this paraneter, increases the anpbunt of pooling
parallelismand the ambunt of systemresources consuned (e.g. nunber of file
descriptors). Increasing the value of this paraneter may or nmy not increase polling
engi ne performance. </ descri ption>
<var Val ue>
<var Type>Il nt eger </ var Type>
<val ue>32</val ue>
</ var Val ue>
</ par anet er >

<par anet er >
<nane>st at usAnal yzer Thr eadPool Si ze</ name>
<title>Status Anal yzer Thread Pool Size</title>
<descri pti on>Thi s paraneter specifies how many threads are in the status anal yzer
thread pool. Increasing the value of this paraneter, increases the ambunt of analysis
parallelismand the ambunt of systemresources consumed (e.g. nunber of file
descriptors). Increasing the value of this parameter may or may not increase status
engi ne performance. </ descri ption>
<var Val ue>
<var Type>Il nt eger </ var Type>
<val ue>20</ val ue>
</ var Val ue>
</ par anet er >

10.19 Reducing the memory footprint in APA

APA (ovet_poll) can have a very large memory footprint. At some customer sites, this
has been as grown to over 1 Gig. With the current design, APA loads all the polled
objects from the topology into RAM.

There is a setting that you can modify to help reduce this footprint. Edit paConfig.xml
and modify value for the parameter |oadOnlyPolledObjectsintoMemory. Y ou can change
thisfrom false to true. Thisinstructs APA to only loaded the “polled” objectsinto RAM
thus reducing the footprint.

But there is a side-effect that you need to be aware of. If you discover a new connection
as part of modifying something in ET discovery, that new connection may not be polled
until you restart APA. We recommend only setting this value if you are up against
memory limitations. We also recommend that you wait until you are finished tuning
APA to set it true.

<par anet er >

<nane>| oadOnl yPol | edObj ect sl nt oMenor y</ name>

<title>Load Only Polled Objects Into Menory</title>

<descri ption>Fl ag that controls |oading of unpolled nodes and interfaces into nenory
If 1 oadOnl yPol | edObj ect sl ntoMenory = true, then nodes and interfaces that are not polled
will not be |oaded into APA nenory. This results in faster startup perfornmance and a
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smaller nmenory footprint.lIt is recommended to use this setting only for |arge
envi ronment s. </ descri ption>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t rue</ val ue>
</ var Val ue>
</ par anet er >

On HPUX PA-RISC, there are challenges allowing a process to grow larger than 1 Gig
RAM. Sometimes we had to increase the maxdsize to 2GB and run the following chatr
commands on ovet_poll executable. Thisis“sticky” and only needs to be done once or at
least until there is a change to the ovet_poll binary like possibly after installing a new
patch or upgrade.

chatr +q3p enabl e /opt/ OV/ bin/ovet _pol |

On Itanium platforms, you need to do things slightly different. The binary must be
compiled to change the default memory model before you can execute this command.
We have recompiled ovet_poll and ovwdb on Intermediate Patch 16 (1P16) to allow this
chatr command. Other binaries like ovet_disco and ovas will be compiled thisway in
IP17. If you need these sooner, contact support.

/usr/bin/chatr +as npas /opt/OV/ bin/ovet_poll

10.20 Side effects of islands of connectivity

If you have “idands of connectivity” (2 or more nodes that are disconnected, per ET,
from other nodes) and the island becomes unreachable via ping and SNMP, APA will not
issue alarms for thisisland since it considers these faults as secondary. For example, in
the illustration below, afailure in the cloud prevents packets from flowing fromthe MS
to Ry, S, 0or E;. APA Analysiswill conclude that these nodes are all Far-From-Fault and
turn them all blue w/o generating any alarms.

FFF

There are workarounds that can help:
- Mark nodesin theisland as “important nodes’ via the file MyHostID.xml,
paConfig.xml and TopoFilters.xml. Search for “Important” in these files for more
details. APA will then issue alarms on secondary failures on these nodes

Mark nodes as “critical nodes’ via CriticalNodes.xml, paConfig.xml and
TopoFilters.xml.

Connect up “islands to mainland” by adding manual connections via connection
editor



Currently NNM 7.53 is planning to issue new alarms for “Remote Site
Unreachable”. This has been well received in beta testing. When released, you'll
probably need to enable this feature in paConfig.xml.

11 Reducing Traps and Events

At many customer sites, NNM is receiving thousands of traps that it doesn’t use. Unless
you really need to see these traps, we recommend that you filter them out of the system.
This is the number one cause of PMD process instability.

As of thiswriting, the only traps that APA uses (provided RecelveEvents parameter in
$OV_CONF/nnmet/paConfig.xml is set to “true”’) are shown here:

Ci scoCol dSt art 1.3.6.1.6.3.1.1.5.1
G scoLi nkDown 1.3.6.1.6.3.1.1.5.3
Ci scolLi nkUp 1.3.6.1.6.3.1.1.5. 4
Ci scoWar ntt art 1.3.6.1.6.3.1.1.5.2
Col dSt art 1.3.6.1.6.3.1.1.5.1
HSRPSt at e 1.3.6.1.4.1.9.9.106.2.0.1
Li nkDown 1.3.6.1.6.3.1.1.5.3
Li nkUp 1.3.6.1.6.3.1.1.5. 4
chassi sChangeNoti fOD 1.3.6.1.4.1.9.5.11.2.0.2
St ackM BMbdul eDown 1.3.6.1.4.1.9.5.0. 4
St ackM BModul eUp 1.3.6.1.4.1.9.5.0.3
War nt ar t 1.3.6.1.6.3.1.1.5.2

All others are ssimply passed through the event pipeline and written into the Binary Event
Store (BES). With ahigh trap reception rate, you’'ll probably be rolling your BES at a
high rate (like every 4 hours). You don’'t want the BES to roll over too often otherwise
you can’t dump a nice history of events for diagnosis.

Evenif atrap is set to log only, it will still pass through the event pipeline and bog down
the system. It isbest to “nip it inthe bud” and remove the trap at the moment it is
received by NNM.

We have a new feature called ovtrapd.conf that can be used the filter traps. Thereisa
nice whitepaper called /opt/OV/doc/WhitePapers/EventReduction.pdf that is shipped with
NNM 7.51. So we won’'t detail the mechanics of using the feature but instead show a
good process.

In order to see what are most frequent traps that you are receiving, you want to run the
command “$OV_BIN/ovdumpevents’ to get an readable format of the current BES.

ovdunpevents > /tnp/ dunpevents.t xt

Then you can evaluate the data looking for trends. Thisfileisn’t the easiest thing to read.
There is a support tool (/opt/OV/support/processEvents) that can help but it isn’t well
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maintained so we don’t guarantee anything. Y ou pass the dumpevents output file as
generated in the previous step. You also provide it an empty file called the summaryfile
where it writes results. We get a number of errors when we run it but you can ignore
them. Plus note that the script processEvents has a problem running on Solaris. To fix
this, you'll need to edit the file and change all of the instances of the work “awk” to
“nawk”.

/ opt/ OV/ support/processEvents dunpevents.txt summaryfile

The summary file will contain information about the number of trap occurrencesin the
BES. Lineswill look like:

Total Nunber for trapld .1.3.6.1.4.1.9.9.43.2.0.1 = 5274
.1.3.6.1.4.1.9.9.43.2.0.1 is not an OV_ event

Thetrap OID is highlighted above. If you wanted to find out what node thistrap is
coming from, smply grep for the OID in the dumpevents.txt file.

Let’s suppose that you decide this trap is not of interest to you. A lot of timesyou won't
have a MIB defining the trap. We find that you can search the internet for most OIDs
and get good results. We googled the OID above and found that it isa
ciscoConfigManEvent which is a notification of a configuration management event.

To remove this trap, you follow the instructions for ovtrapd.conf and place the trap in the
file as shown here. Y ou can add additional traps aswell. Y ou can also restrict thisto a
set of IP addresses but for this example we'll suppose we want to throw away that trap
from any source IP address. To do that, put the following entry into the file. Note that
you can add multiple traps to the same line. Y ou can also use wildcarding. But you can’t
put the same | P on multiple lines so you must put them on the same line with commas
separating them. Try to make the line as short as possible using wildcards.

<k X L*.*,.1.3.6.1.4.1.9.9.43.2.0.1,.1.3.6.1.4.1.9.5.0.*>

In afuture, we hope to develop the ability to specify what traps you want to keep rather
than what to exclude. That way you could simplify thisfile.

We also have implemented the ovtrapd filtering in such away that you can specify the
number of seconds as criteriafor calculating the event rate. That is, now a new option
called "-c" has been added to ovtrapd to handle the number of seconds criteriafor trap
filtering. For example, if we want to block an | P address/interface from which we get 10
events every minute (60 seconds) then we need to create an entry like

"OVs YES START:pmd:-b 10-c 60:0OVs WELL_BEHAVED::" in ovtrapd.Irf file
and here -b is number of events and -c is number of seconds for which we want to
monitor the event rate.

Please note that this event rate will get calculated on receipt of every <n> number of

events specified with -b option. In example mentioned above, we will block the device/IP
(@l the events) if 100 events are generated from it in less than 60 seconds and then welll
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monitor the device again for next 100 events and see if we have these events generated in
less than 60 sec and if not, then we'll unblock the device/lIP and events will resume to
enter in NNM from these I Ps.

Also note that any option specified in ovtrapd.Irf does not work along with ovtrapd.conf
options. All the I Ps specified in ovtrapd.conf are blocked forever from sending trapsto
NNM station.

Following is an example to enable tracing for ovtrapd to get alist of blocked devices.
Please change the $OV_L RF/ovtrapd.Irf file as follows:
"OVs YES START:pmd:-b 10 -c 60:0Vs WELL BEHAVED::"

We recommend that you do this process a number of times and try to cut down on the
number of traps. Try to get it down to one trap per minute.

You can do alittle bit of cutting down of NNM generated events by changing the

category of them from LOGONLY to IGNORE. Thisisdone by editing trapd.conf or in
the Event Configuration GUI. Inthe GUI, IGNORE iscalled “Don’t log or display” But
use caution when doing this. Some of these alarms are used by other parts of the system.

An example of an alarm you might choose to ignore isthe OV_Bad_Subnet_Mask.
Maybe you don’'t ever care about those. So rather than making them LOGONLY, make
them IGNORE instead. Y ou can do this by editing trapd.conf directly. Make sure you
create a backup first. After making the change, run “xnmevents —event” and “xnmtrap —
event” to read the change in.

Before
EVENT OV_Bad_Subnet _Mask .1.3.6.1.4.1.11.2.17.1.0.58982414 "Configuration Al arns" M nor

After
EVENT OV_Bad_Subnet _Mask .1.3.6.1.4.1.11.2.17.1.0.58982414 "1 GNORE" M nor

We recommend that you use the GUI instead to make this change. Select the event and
select Modify Event...
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i Event Configuration for ksmithux.cnd. hp.com

Then change the Category to “Don’t log or display”. Then choose OK and select File ->
Save to make the change active.

%4 Event Configurator, f Modify Event for ksmithux.cnd. hp.com

EE— =

If you change events to IGNORE, then you should check to see if the alarm has any
correlations associated with it. If so, you should disable them. Even though the event is
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being ignored, it till flows through the event system and will potentially cause extra
correlation work and internal events.

Let’s continue our example of .1.3.6.1.4.1.11.2.17.1.0.58982414. Let'slook at the
RepeatedEvent circuit to check if it is correlated. Launch the ECS Configuration GUI.

Event Correlation in Selected Stream: default -

Status Mame | Description |

Enabled Compaoser Access to Correlation Composer Disable
Enabled ConnectorDown Metwork Connector Down Carrelation

Disahled M ServerDiown ManageX Server Down Carrelation Describe...
Enahled Painise Painise Events Correlation

RepeatedEvent Repeatad Ever correlation

Disabled Schedulediaintenance Scheduled Maintenance Correlation

Click Modify on the circuit. Then click View/Modify on the InputEventTypelist.

23 RepeatedEvent - Modify @

Farameters for correlation: RepeatedEvent

Marme Current Value Modified| Update Description 2 ;"{,}'i'g{};;j'r’.ﬁaﬁm,_f%
HoldFirstEventTime 10m Static The time period to hold the first event for later correlat -
MaxHaldFirstEvents 10000 Static The number of first' events to hald for later carrelation

InputEventTypelist . Cwnamic Input event ty and source identification
RepeatedTimewsindow|10m Static The titne window for carrelation
CreatellpdateEvent false Cynamic |Create update of output event with suppressed count
Rallingwind aw false Dynarmic |Use Ralling ar Fixed time window w
£ >
(04 | | Cancel | Help |
Jawa Applet wWindomw
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Then look for the event OID .1.3.6.1.4.1.11.2.17.1.0.58982414. You can seethatitisin
the list. We suggest you change value to false so it won't be correlated.

‘A InputEventTypeList - Modify

Mame: Tupe:
|InputEventT\ypeList Dictionary

Table values:

Input Event 01D/ Generic Trap String |[Event Source |dentification |[Enakle Event Type Add Row
1.3.6.1.41.11.217.1.0.58916867 4 true Dalete Row
1.36.1.4111.217.1.058916864 1.361.4111.2172.20 [falze

"authenticationF ailure" "agentaddr false M
"egpMeighborLoss” "agentaddr false

1.3.6.1.41.11.217.1.0.98852422 1.36.1.4111.217.2.2.0 [true

"linkLip" "agentaddr false

1.36.1.4111.217.1.0.589324M1 1.361.4111.2172.20 (true

1.361.4111.217.1.058582423 4] true

1.36.1.41.11.217.1.0.40000011 G true

136 1.40.11.2971.0.58982414 1 [1.3.61.4111.21722.0 |ftrue

"linkDown" ] "agent-addr” false

"warmStart” "agentaddr false

"coldStart" "agentaddr false

1.36.1.4111.217.1.058785794 S true

Current Walue: |true
Descrintion

12 Backup Strategies

When using Extended Topology, you need to decide the best way to backup the Solid
database since that is the primary database used by ET. Extended Topology will make
your Solid DB much larger than it used to be. Many large networks can use up a least 2
Gigabytes of space.

By default, Solid is setup to automatically run a Solid backup nightly a 11pm. In
addition to this, if you use ovbackup.ovpl, it also backs up the Solid database.

When you perform ovbackup.ovpl or the automatic Solid backup, the backup is written to
the $OV _DB/analysis/default/backup subdirectory. Thisis usually on the same volume
as the Solid database (just one directory up). It’s not agood practice to backup onto the
same volume as the original data. For Unix customers, we recommend that you create a
symbolic link for this backup subdirectory. Link it to an different volume on another
disk.

Y ou can also change the location of the Solid backup but it's alittle tricky. To change
the location of the Solid backup, edit $OV_DB/analysis/default/solid.ini. Thereisa
section that reads:

[ General]
BackupDi r ect or y=backup

50



This directory isrelative to Solid working directory. You cannot put an absolute path
here like /var/tmp/backup. You could do some “dot-dotting”. On Unix, to get to the
directory /var/tmp/solidbak, change the file to read:

[ General]
BackupDirectory=../../../../../../tmp/solidbak

Another adternative isto leave the backup in the backup subdirectory but move the
contents to another volume immediately after completing the backup.

We usually recommend disabling the automatic Solid backup and using the
ovbackup.ovpl explicitly to backup your data. To do this, edit the file
$OV_DB/analysigdefault/solid.ini and put a semicolon in front of the line that reads
“At=23:300 backup” and restart solid (ovdbcheck). This requires stopping many other
NNM processes so do this during a scheduled downtime.

; The following entry will schedule a enbedded dat abase backup each ni ght
; at 11:00pm Renpbve when using ovbackup.
; At =23: 00 backup

13 GUI

There are afew simple changes for the GUI that we recommend everybody use. We'll
detail these first. We'll also discuss container views.

13.1 Simple Changes

13.1.1 Changes to web.xml

The following changes are all made within the file $OV_ A S/webapps/topol ogy/WEB-
INF/web.xml.
The first simple step we recommend is that you change the default Neighbor
View hop count to one. In acomplex network, a Neighbor View with 2 hops can
be too complex. Starting with 7.51, you can now adjust this default value. To do
this, change the defaultNumHops value from 2 to 1.

<i nit-paranm>
<par am name>def aul t NumHops</ par am nane>
<par am val ue>1</ par am val ue>
</init-paranr

The second thing we always do is change Node View to use ET filters rather than
classic NNM filters. ET filters are much faster. Change the value for
enableETFilters from O to 1.

<i nit-paranm>
<par am name>enabl eETFi | t er s</ par am nane>
<par am val ue>1/ par am val ue>
</init-paranr
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The third thing we recommend is to change Interface View to not show disabled
interfaces. Change the parameter includeDisabled from 1 to O.

<i nit-paran>
<par am name>i ncl udeDi sabl ed</ par am nane>
<par am val ue>0</ par am val ue>
</init-paranr

The fourth recommendation is to restrict the Neighbor View to only use ET data.
Change the value for restrictTOET from O to 1.

<i nit-paranm>
<descri pti on>
This paraneter will linmt the NeighborViewto use ET Database only. Wen
this feature is enabled NeighborView retrieves infornmation only fromthe
ET Dat abase and does not use Base Topol ogy.
The default value of restrictToET is 0 and this feature will be disabled.
To enable this feature change the value to 1.
</ descri pti on>
<par am name>r estri ct TOET</ par am name>
<par am val ue>1</ par am val ue>
</init-paranr

13.1.2 Changing the java heap size

Y ou may wish to increase your java heap size for ovas. Thiswill help reduce running out
of memory in complex environments. To do thisyou simply add “-Xmx512m” to the
arguments of ovasin the ovas.rf file. This specifies a heap size of 512 Meg. You can go
as large as 1024m but we usually don’t recommend going higher than that. If you go this
big on HPUX paRisc, then you'll need to run the chatr command on ovas as shown
previoudly for ovet_poll. The default is 256MB if nothing is specified. You can follow
these steps:

1. Edit /etc/opt/OV/share/lrf/ovas.Irf
2. Follow instructions in the comments at the top of thisfile to add an argument to
the ovas startup. Insert the following string between the second and third colons
of the second line:
-Xmx384m

The resulting string should look something like:
OVs_YES_START: ovt opnd, ovdbcheck, ht t pd: - Xnx512m OvVs_WELL_BEHAVED: 15: NOPAUSE:

3. Run “ovaddobj $0OV_L RF/ovas.Irf”

13.1.3 Changing Topology Cache

Another recommendation is to increase java topology cache by creating
dynamicViewCacheSize.txt file under $OV_CONF for ovas performance reasons
though we don’'t do this at many sites.

nodeCacheSize The number of nodes to be stored in cache
interfaceCacheSize The number of interfaces to be stored in cache
addressCacheSize The number of addresses (IPV4,IPV6) to be stored in cache
subnetCacheSize The number of subnet (IPV6) to be stored in cache
vlanCacheSize The number of vlan to be stored in cache
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HSRPCacheSize The number of HSRP to be stored in cache
VRRPCacheSize The number of VRRP to be stored in cache

nodeCacheSize 10000
interfaceCacheSize 150000
addressCacheSize 2000
subnetCacheSize 400
vlanCacheSize 400
hsrpCacheSize 60000
ifcCacheSize 100000
cardCacheSize 20000

nodeCacheSize should be more than the value of “ovtopodump -1 | grep "NUMBER OF
MANAGED NODES".

interfaceCacheSize should be more than the value of “ovtopodump -I | grep "NUMBER
OF INTERFACES"”

13.2 Container Views

There is a nice whitepaper written on Container Views so we won't go over the same
material here. Please read this whitepaper located at

/opt/OV /doc/WhitePapers/ContainerAdministration.pdf available with NNM 7.51.
Instead, we'll discuss some strategies for Container Views.

Containers are based on ET Filters so you must understand ET Filters. Please seethe
section Filtersin ET.

Containers are a great way to divide up your ET Nodes so they can be more easily
viewed and monitored from amap. It isimportant to note that containers only apply to
nodes (not other entities like interfaces, HSRP groups, etc.) It’'s aso important to note
that nodes can be in more than one container. The only real restriction on containersis
that they must be hierarchical and the each container name must be unique. So you'll
need to be creative on your layout.

Most customers prefer to create containment based on geography using name based
filters. For example, if you have four cities that your nodes are in and then have
buildings within these cities, you might create a hierarchy similar to that shown below.
Notice that in addition to geography, you can create containers with based on logic like
System OID. Theselogical containers are represented with checkered background whi
geographical containers are the other shade of gray.

le
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Norway

Oslo Trondheim Bergen Harstad

Firewalls in
Network

| | | I—— |

Bldgl Bldg2 Bldg1 Bldg1 Bldg2 Bldg1

-

b Servers in Bergen
Servers in Oslo g

Let’s develop this example. Your first step isto design your hierarchy on paper. | don’'t
recommend doing thisreal timein the GUI because it is currently difficult to modify
container positionsin the hierarchy. The only the problem with the layout above isthat is
has repeated names like Bldgl. Thisisn’'t allowed in Container Views. So you would
need to name the container Oslo_Bldgl and Bergen_Bldgl or something like that.

The next step isto develop filters for each container. 'Y ou would probably develop filters
based on name or SysName if you use a naming convention that indicates location. For
the logical containers like Firewalls in Network, you would probably use a sysOID filter.

The final step would be create the containers in the GUI following the whitepaper
instructions and assigning filters to them.

Best Practices

We recommend against using the “Include Node . . .” menu item if you are using
filters. Thetwo don’'t mix well. It'sbest to create filters and then strictly use
filters for containment.

Y ou can use JPG or GIF files for background images. We prefer JPG as they
resize better.

We prefer to not show connectivity between containers by setting
showContainerConnectivity="false” on all containers. Thereisan examplein the
whitepaper.

Don’'t put too many nodes in a container. They are recalculated every time you
enter one. We try to cap the size around 200 nodes or so.

If you don’t care about connectivity, set showNodeConnectivity="false’ on all
your containers. This makes them much higher performance. Y ou can aways
launch a neighbor view for connectivity from anode. In my opinion, connectivity
within a container can be problematic because key nodes may not pass the filter
and may not be in the container, thus possibly degrading the accuracy of the
connectivity.



Default behavior of containers status propagation:

Containers behave the same way as that of APA for status propagation and
following are the different status propagation metrics for containers:

o Container turns Minor/Y ellow if any underlying node is Minor or Critical,
irrespective of other nodes' status.

o0 Container turns Critical if all the underlying nodes are marked Critical

o Container turns Normal if everything underlying the container is
Green/Normal

0 The main difference between APA and containersis, Container turns
“Unknown”/Blue if al the underlying nodes in the container turn
Unknown/Blue.

0 Thismeansthat Container status does not propagate in APA style if
underlying nodes are Unknown. For example, if all the nodes underlying the
container are Unknown except one then the container status will be the
status of that remaining one node.

0 For example, when a Container was "Minor" dueto 1 Minor + 1 Normal +
<n> Unknown nodes underlying. When a"Minor" node became
"Unknown", the container changed to "Normal" as mentioned above in the
text.

This behaviour is happening due to the fact that containers are implemented
to indicate the root cause/primary failure of a problem. Y ou get an overal
picture of your network on where the failure has happened (shown with a
Minor container). Since, the Unknown nodes are secondary failure, they are
the impact of the root cause but Containers are not meant for showing the
impact of secondary failures.

Better idea to see the impact of the failure would be to look for the container with aroot
cause node, go inside that container, open a 1-2 Hops neighbour view for the affected
root cause node. To go beyond 2 hops in neighbor view, we recommend using “Expand
connecting neighbors’ option of a“Right-click” menu on a particular node.

13.3 Advanced Container View Tasks

There are afew things not covered in the containers whitepaper that we' |l address here
including deleting containers, renaming containers, scaling background graphics,
resetting containers. The current plan isfor NNM 7.53 to support deleting and renaming
viathe GUI.

13.3.1 Delete Container

To delete a container, you can't use the GUI. Instead you must edit the file
$OV_DB/nnmet/containers.xml. We recommend that you ovstop ovas when you edit
thisfile since it could be changed by ovas. Y ou then remove any containerReference tags
and the entire container tag for the container you wish to delete. Some examples are
highlighted in red below. Y ou would completely delete the lines shown in red.
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Y ou can use the reload feature

(http://<hostname>: 7510/topol ogy/home?rel oadContai ners=true) if you prefer to leave
ovas running while making these modifications but we have found it dangerous to edit
this file with ovas running.

A note of caution: Due to aminor defect, the containers.xml file may contain many blank
lines (sometimes hundreds of blank lines). Watch out for that. It can be misleading.

Y ou might think you are at the end of the file when you aren’t. Y ou can delete the blank
linesif you wish.

<container name="Fort Collins">
<containerReference name="MPLS nodes" x="356.8442951222268" y=""182.8442951222268"/>
<containerReference name="NTC" x="531.3368696285949" y="180.336865628%543"/>
</containers>

<container name="MPLS nodes'> <filter name="MplsName"/>
<topoNode name="mplspel6.cnd.hp.com" ... />
<topoNode name="ntc6k0l.cnd.hp.com™ ... />

</container>

13.3.2 Rename Container

To rename a container, you must edit the file $OV_DB/nnmet/containers.xml. Again we
suggest you stop ovas during when making this change. Then simply replace

name="old name”

with

name="new name’

in al locations. Thesetags are highlighted in red below.

<container name="Fort Collins"»
<containerReference name="MPLS nodes' x="356.8442551222268" y="182.84425951222268"/>
<containerReference name="NTC" x="531.3368656285549" yv="160.3368696265949"/>
</containers

<container name=""MPLS nodes'> <filter name="MplsWame"/>
<topolode name="mplspel6.cnd.hp.com" ... />
<topolode name="ntcek0l.cnd.hp.com" ... />

</containers

13.3.3 Scaling Background Graphics

Sometimes you might wish to change the size of the container icon compared to the
background graphic. For example, the picture shown here has fairly large container
icons. You may prefer that they be smaller.
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If you want to change the size of the container relative to the background graphic, you
must increase the size of the background graphic. | use Microsoft Office Picture Editor
since it comes with Microsoft Office. Y ou can also use any Picture Editor you prefer.
L et me show the steps using the Microsoft product.

First, load the original graphic into the Picture Editor. Then select Picture-> Resize...
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i Fle Edit iew | Picture | Tools  Help

EEﬂihortcuts... | g & Auko Correct Chrl+Q | [ 70% = @

Brightness and Contrast...

Color. ..

Crop...

Rokate and Flip. ..
Red Eve Removal, .,

9 ®@ 7 @™

Resize... [

¥
|
x,

Compress Picmges. 00

'

Vastaraian '1—,{

Lofoten . D‘ﬂ

¢
Norwegien Sea :ﬁéﬁf? :';{;
# lang

Increase the size of the picture. We like to increase it as a percentage of the original.
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Type a question For help =

A | % Edit Pictures... | 'ﬁ Auto Correct !

EResize v X
@ a
1 files selected

Resize settings
Make picture Fit inside:
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() Predefined width x height:
| ]

() Custom width = height:
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pixels

(%) Percentage of original width =
height:

Size setting summary

Criginal size: 800 x 927 pixels
Mew size: 1200 x 1391 pixels

SWEDEN

Save this new JPEG file. We would then place the new file on top of the old file under
$OV_WWW/htdocs/images/backgrounds. Y ou can either reload it into ovas
(http://<hostname>: 7510/topol ogy/home?rel oadContainers=true) or restart ovas. Then
you should see a view with containers scaled to a smaller size.
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13.34 Resetting Containers

We' ve seen occasionally customers want to “reset” or “rebuild” acontainer. Why ever
do this? If you have radically changed your NNM database and this caused al the NNM
Object IDs to change (like deleting the NNM database and rediscovering the network
completely), this may cause challenges to containers since they store the NNM Object 1D
aswell as position. If you only populated your containers with filters, then simply select
the container of interest, choose Set Container Filter, and select the same filter as before.
Thiswill repopulate the container. FY|, thiswill also generate many blank linesin the
containers.xml file so watch out for this. It doesn’t hurt anything can be misleading when
editing the file by hand.

13.4 Adding Authentication to HomeBase
Y ou might require authentication to HomeBase. This can be easily added.

Edit 3OV _A Siwebapps/topol ogy/WEB-INF/web.xml and remove the XML comments
highlighted below to activate the block of XML.

<security-constraint>
<web-resource-col | ecti on>
<web-r esour ce- name>Dynami ¢ Vi ew Access</ web-resour ce- name>
<url-pattern>/*</url-pattern>
</ web-resource-col |l ecti on>
<aut h-constrai nt >
<r ol e- name>oper at or </ r ol e- name>
<r ol e- name>adni ni strat or </ rol e- name>
</ aut h-constrai nt>
</ security-constraint>
e

Then add users and assign roles in thisfile:
$OV_ A S/webapps/topol ogy/WEB-INF/dynamicViewsUsers.xml

Y ou probably already set up one user a installation time. You can just use that one if
you wish or you can add others.

Notice that the users are added between the tomcat-users tags. So the original looks like
thisif you have one user with “admin” and “secret” name and password.

--><toncat - user s>
<user nanme="adm n" password="secret" rol es="adm nistrator"/></tontat-users>

To add additional users, make it look like the XML shown below or better yet, you can
use the tool $OV_BIN/dvUsersManager.ovpl. Thereisa“man” page available for this
tool.

-->

<t ontat - user s>

<user nanme="user 1" password="topsecret" rol es="adm nistrator"/>

<user nanme="user?2" password="evennoretopsecret" roles="adm nistrator"/>
<user nanme="adm n" password="secret" rol es="adm nistrator"/>
</tontat - user s>
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NOTE: This security doesn’'t work all that well in the webstart solution because you keep
having to authentic the browser whenever you launch to a browser from homebase (like
Node Details).

Thelogin is done using BASIC method of authentication, which sends passwords as
cleartext across the network. Y ou can instead use the more secure MD5 passwords. To
use this, instead of entering the cleartext password in the dynamicViewsUsers.xml file,
you must enter the result of

“$OV_JRE"/ bin/java -classpath \
"$OV_AS"/server/lib/catalina.jar:"$OV_AS"/bin/ bootstrap.jar \
org. apache. catal i na. real m Real nBase -a MD5 topsecret

where topsecret is the password you want to enter.

Further on IPF, you need to use
"$OV_JRE"/ bin/ 1 ABAN java -classpath \
"$OV_AS"/server/lib/catalina.jar:"$OV_AS"/bi n/ bootstrap.jar \
org. apache. catal i na. real m Real nBase -a MD5 topsecret

and make surethat LD_LIBRARY_PATH is set to:
$OV_JRE/ i b/ | A64N: $OV_JRE/ | i b/ | A64AN server

Thiswill return a string like:
t opsecret: ea847988ba59727dbf 4e34ee75726dc3

and you will need to use "ea847988ba59727dbf4e34ee75726dc3" as the password field in
the dynamicViewUsers.xml file.

It will now look something like:

<t ontat - user s>

<user name="user 1" password=" ea847988ba59727dbf 4e34ee75726dc3" rol es="adm ni strator"/>
</tontat - user s>

Next, you will next need to make a change to the $OV_A S/conf/server.xml file to add the
digest parameter of the <Realm> element of the topology Context to digest="MD5".

Go to the section that looks like:

<l-- Network Node Manager Dynanmic Views Context

To use MD5-hashed passwords, add

di gest =" MD5"

to the Real m el ement bel ow
-->
<Cont ext pat h="/topol ogy" docBase="t opol ogy" debug="0">

<Real m cl assNanme="or g. apache. cat al i na. r eal m Menor yReal nt'

pat hname="webapps/ t opol ogy/ VEEB- | NF/ dynani cVi ewsUsers. xm " />

</ Cont ext >

And change it to say
<Cont ext pat h="/topol ogy" docBase="t opol ogy" debug="0">
<Real m cl assNanme="or g. apache. cat al i na. r eal m Menor yReal nt'
pat hname="webapps/ t opol ogy/ VEB- | NF/ dynami cVi ewsUser s. xm "
di gest =" MD5"
/>
</ Cont ext >
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14 Filters in ET

14.1 Introduction to filters

ET filters are used whenever there is a need to obtain a subset of objectsin ET Topology
of a particular type that meets some set of conditions. ET filters are heavily used by APA
to configure polling policies. They are aso used by the GUI with Container Views and
Node View (if you switched it to use ET filters).

We won’t cover al the details of filters here but | will give an overview. You can pick
up alot by ssimply looking at the TopoFilters.xml file and playing around with it. We
will include a number of sample filters.

ET filtersreside in the file $OV_CONF/nnmet/topology/filter/TopoFilters.xml. Always
make a backup before editing thisfile. If you want to dig further, you can study the XSD
schema definition files. The are located at

$OV_CONF/nnmet/topol ogy/filter/TopoFilter.xsd
$OV_CONF/nnmet/topology/filter/TopoFilterCommonTypeDef.xsd

AnET filter is:
* A set of assertions and/or other ET Filters
» combined by logical operators
» for the purpose of finding a particular subset of objectsin ET Topology
» whereal of the objects returned by a given filter are of the same type.

Assertions are like really alot like filters. In ET filters, an assertion is a specia kind of
filter that uses built-in conditions. These built-in conditions are usually based on
attributes that are part of an ET discovery of an object.

Logical operators are used to combine filters or other assertions. Operators include
AND, OR, NOT and NOOP. NOOP issimply a placeholder for asingle filter or
assertion.

14.2 Structure of TopoFilters.xml
The top-level structure of TopoFiltersxml is

<filters ...>
The set of filter definitions (using the filter tag):
<filter name="name"...>
</[filter>

The set of assertion definitions (using assertion tags):
<nodeAssertion name="nanme" ...>

</ nodeAssertion>

<interfaceAsserti on name="name" ...>
</interfaceAssertion>

<addr essAsserti on name="nanme" ...>

</ addr essAssertion>

</[filters>
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14.3 Creating, Modifying and Verifying Filters

To create or modify afilter, you edit the TopoFilters.xml file and add or change the
XML. When creating new filters, the typical processisto find afilter that is similar to
what you want, make a copy of it in the file, and then modify it to meet your needs.
Unlike paConfig.xml, thisfile isn't as sensitive to position of the filtersin the file. You
don't need to worry if afilter needs to be placed "above or below" another filter that
might match. That's because objects can match multiple filters without a problem. We
believe the only restriction is that you must adhere to the structure of the file and have the
filters above the assertions.

After you create or modify afilter, you should test it. Please run,

ovet _t opodunp. ovpl —Ifilt
and look for you newly created filter in the output. If you have an error in your syntax,
this command will fail and will give you quite a bit of diagnostic information to help you
find the error.

If you filter shows up okay, then run "ovet_topodump.ovpl -?* to get alist of options for
this command. Depending on what type of filter you are developing, you'll run different

options. For example, to get alist of hodes passing a node filter, you would run
ovet _t opodunp. ovpl —node —filt <your_node_filter>

To get alist of interfaces passing an interface filter, run
ovet _topodunp.ovpl —if —filt <your IF filter>

14.4 Assertion Types

When creating assertions, you'll need to know the available attribute types. Let me list
these here.

Node Assertion Attribute Types

Attribute Type Description
name The primary DNSName of the Node
SysName SysName of the node
lastUpdateTimeUTC The last time the node was updated.
description The description of the node
|PAddress Address on the node
sysOID Match on SNMP System OID of the node
capability The capability of the node
status The overall status of the node
extensibleAttribute An “extensible” attribute of the node
HostIDFile Use predefined HostName or IP Address

inthefile
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Card Assertion Attribute Types

Attribute Type

Description

name

The nnm entity name of the card

lastUpdateTimeUTC

The last time the card was updated. The
time vaueisin time t format

index The card index

description The description of the card

type MIB type field on the Card

model MIB model field on the Card

n MIB serial number field on the Card
fwversion MIB firmware version field on the Card
hwversion MIB hardware version field on the Card
swversion MIB software version field on the Card
componentName SNMP System OID of the card

status The overall status of the card

extensibleAttribute

The extensible attributes of the card

cardAdminStatus

Card adminstration status

cardOper Status

Card Operation Status

mibType

MIB type from which card data was read

Interface Assertion Attribute Types

Attribute Type

Description

lastUpdateTimeUTC

The last time the interface was updated.

IPAddress | Pv4 address bound to the Interface

ifDescription The description of the interface

ifAlias Interface Name Alias

ifName Interface Name Alias

ifl ndex Interface Index

vlanPortType Therole of thisport in VLAN config:
trunk, access or no VLAN

ifAdminState Interface adminstration state

ifOperStatus Interface Operation Status

ifType Interface Type

if Speed Interface Speed

status The overall status of the interface

extensibleAttribute The extensible attributes of the interface

capability The capability on the Interface

Specia Case: Association Assertions

» “Associations’ define assertions based on associations with other related objects.

» Examples of associations.

— A node or card association could be defined to match the set of nodes or
cards containing a particular set of interfaces.
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— Aninterface association could be defined to match the set of interfaces
found in a particular set of nodes.

14.5 Filter Examples

In this section we will give a number of examples. We'll include an XML comment
describing the filter. With minor modification, you should be able to use these examples
in your own deployment. Sometimes the syntax is complex and these examples will
prove helpful.

<l-- Node filter for nodes that have an address in a range or a wildcard nane. Note that
this will select a node if it has ANY address in this range. This is not the managenent -
address or the DNS address. Also note that this nane is the actual nane in the database
not necessarily the DNS name. -->
<nodeAssertion nane="groupl" title="groupl"
description="Goup of nodes based on nane or |P address">
<oper at or oper="OR"'>
<attribute>
<nane>
<string>*dgr*</string>
</ name>
<lattribute>

<attribute>
<| PAddr ess>

<l Pv4>
<addr ess>10. 102. *. *</ addr ess>
</1Pv4>

</ | PAddr ess>
</attribute>
</ oper at or >
</ nodeAssertion>

<l-- This one uses both SysNanme and "name". Sysnane is the value fromthe MB. The
"nanme" value is how the node is actually naned in the NNM ET topol ogy. This nane could
have cone from ot her sources such as DNS nane. -->

<nodeAssertion nane="FortCollins" title="FortCollins" description="Fort Collins">
<oper at or oper="0OR"'>
<attribute>
<SysNane>abcon* </ SysName>
<lattribute>

<attribute>
<nane>
<string>ns. corp.conx/string>
</ name>
<lattribute>

<attribute>
<SysNane>*sshsrv*</ SysNane>
<lattribute>
</ oper at or >
</ nodeAssertion>

<l-- Node filter for nodes that have an address in a range and have certain sysOD.
The logic is ((sysOD | sysOD | sysOD) & (addrRange | addrRange))
>

<nodeAssertion nane="Col oradoServers" title="Col oradoServers"
descri ption="Col orado Servers">
<oper at or oper="AND"'>
<oper at or oper="OR"'>
<attribute>
<sysO D>1.3.6.1.4.1.311. *</sysO D>



</attribute>

<attribute>
<sysO D>1.3.6.1.4.1.11. *</sysO D>
</attribute>

<attribute>
<sysO D>1.3.6.1.4.1.42. *</ sysO D>
</attribute>
</operator> <!-- END "OR' -->

<oper at or oper="OR">
<attribute>
<| PAddr ess>

<l Pv4>
<addr ess>10. 102. *. *</ addr ess>
</1Pv4>

</ | PAddr ess>
</attribute>

<attribute>
<| PAddr ess>

<l Pv4>
<addr ess>10. 32. 121-122. *</ addr ess>
</1Pv4>

</ | PAddr ess>
</attribute>
</ operator> <!-- END OR -->
</ operator> <!-- END AND -->
</ nodeAssertion>

<l-- This is howto build a node filter and an associated interface on the node.
You woul d use these filters to set a polling policy on nodes of a certain
type and a polling policy on the interfaces on those node.
We first identify the nodes using SysName. Then we identify interfaces on
these nodes with the interfaceAssertion that follows.

-->

<nodeAssertion nane="WFi-AGR"' title="WFi-AGR"' description="Aggregator for W-Fi ">

<oper at or oper="OR"'>
<attribute>
<SysNane>al * </ SysNanme>
<lattribute>

<attribute>
<SysNane>bo* </ SysNanme>
</attribute>
</ oper at or >
</ nodeAssertion>

<interfaceAssertion nanme="|FWFi - AGR" title="1FW Fi - AGR"
description="Interfaces for W-Fi ">
<oper at or oper ="NOOP" >
<interfaceAssoci ation ascType="i nNode">W Fi - AGR</ i nt er f aceAssoci ati on>
</ oper at or >
</interfaceAssertion>

<l-- interface filter for name not a |oopback -->
<interfaceAssertion name="|FNaneNot Lo0" description="1F Not Loopback0">
<oper at or oper="NOT">
<attribute>
<i f Name>Lo0</ i f Name>
<lattribute>
</ oper at or >
</interfaceAssertion>

<l-- interface filter for name with G in it -->
<interfaceAssertion name="1Fgi g" description="1F Not Loopback0">
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<oper at or oper ="NOOP" >
<attribute>
<i f Nane>*G *</i f Nane>
</attribute>
</ oper at or >
</interfaceAssertion>

<l-- interface filter for certain IF Descriptions -->
<interfaceAssertion name="|FDescVl an" description="1F Description filter">
<oper at or oper="OR"'>
<attribute>
<i fDescription>*unrouted*</ifDescription>
<lattribute>

<attribute>
<ifDescription>*virtual *</ifDescription>
<lattribute>
</ oper at or >
</interfaceAssertion>
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15 Appendix A — A new and improved Swouter filter

Problem Statement:

Nodes that are both a switch and a router (Cisco 6509 for example) are polled by APA as
arouter. We will call these “swouters’ in this document. When a node is both a switch
and arouter, it ispolled asarouter. By default, APA polls al unconnected interfaces on
routers. If there are interfaces on these “swouters’ connected to workstations, the noise
level can become unmanageable as anytime a workstation powers up/down an

apa if_down and/or apa_if _up event is received.

Solution:

The solution to this problem is to create a new filter for swouters and set up APA
interesting interfaces on swouters. This new document has an improved version of the
filters that alows more flexible polling configuration. The previous version restricted
polling to only the connected interfaces on swouters. Many customers needed to monitor
other interfaces in addition to the connected interfaces. This new version is extensible to
alow this.

Word of caution: Always make a backup copy of paConfig.xml and TopoFilters.xml
before making changes. Also note that the placement of the XML in the paConfig.xml
and TopoFilters.xml is approximate. This could be different if you' ve made previous
changes to your files. We' ve just given guidelines for the locations. But location within
the files can be critical. For TopoFilters.xml, try to place various filters next to other
filters of the same style. For instance, place “interfaceAssertion” sections next to other
interfaceAssertions. Place “filter” sections next to other filters.

To implement the solution, we will edit TopoFilters.xml and create filters for swouters
and for interfaces on the swouters. We then edit paConfig.xml and add a new class for
swouters and interfaces on swouters. We change the settings to poll “interesting”
interfaces and not poll “not interesting” interfaces. “Interesting” interfaces will include
connected interfaces but can be extended to include other interfaces as well.

We will created an interfaceAssertion called InterestingSwouterlF. All Interesting
Swouter Interfaces will be polled with SNMP and Ping (if they have an address on them).
Presently only connected interfaces on swouters are marked as “interesting”. But you can
easily add other interfaces that you would like monitored. We have a couple of
commented out examples. Maybe you would like to monitor al loopback interfaces on
swouters. Then smply add the following attribute to the OR condition. (We have this
particular one commented out in the XML.)

<attribute>
<i f Type>24</if Type>
</attribute>
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Or maybe you mark an ifAlias on al the interfaces you want polled. Then use the ifAlias
attribute to catch these. Y ou can add other interfaces attributes to this OR condition to
meet your needs.

< - - R R T R TR R T R TR R
HP added this. This identifies interfaces on swouters
that we want to nonitor. Custoners should nodify this portion
to nmeet their needs. |In particular, they could renmove or nodify
the ifType and ifAlias or add other criteria to the OR condition.
HHHHHHHHHHHH A - - >
<interfaceAssertion name="Interesti ngSwouterl F* title="" description="">
<oper at or oper="OR">
<attribute>
<capabi | i t y>i sL2Connect ed</ capabi l i ty>
</attribute>
<l--  These are exanples. Renove the comment marks to use these
iftype 24 = | oopback
<attribute>
<i f Type>24</if Type>
</attribute>
<attribute>
<ifAlias>MWAlias*</ifAlias>
</attribute>

</ operator> <!-- End OR -->
</interfaceAssertion>
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TopoFilters.xml
Make a backup of thefile
Edit TopoFilters.xml
Place the following filter above * <filter name="CiscoRouter"’

<l-- HP added this -->

<filter nanme="isSwouter" objectType="Node" title="isSwouter" description="Nodes which

have switching and routing capabilities">
<oper at or oper="AND"'>
<filterName>i sRouter</filterName>
<filterName>i sSwitch</filterName>
</ oper at or >
</filter>

Add the following filter above the WanlF interface filter ‘ <filter name="WanIF"

<| - - HHHHHBRHHH R HH R R R
HP added this. This identifies interfaces on Switch/routers
that are nonitored.
BHHHHH BRI H TR - - >

<filter nane="Pol | edSwouter| F' object Type="Interface" title="" description="">

<oper at or oper="AND"'>
<filterName>l nterfacel nSwout er</filterNane>
<filterName>l nterestingSwouterl| F</filterName>
<filterName>Adm nUpOr Test I nterface</filterNane>
</ oper at or >
</filter>
<! - - HHHBHHBHHBHH BT T H R TR H R R R R
HP added this. This identifies interfaces on Switch/routers
that are not nonitored.
BHHBHHBHH AR H R H R H B R R H R R R R H RS - - >

<filter nanme="Not Pol | edSwout er| F* obj ect Type="Interface" title="" description="">

<oper at or oper="AND"'>
<filterName>l nterfacel nSwouter</filterName>
<oper at or oper ="NOT">
<filterName>l nterestingSwouterl| F</filterName>

</ operator> <! — end NOT -->
</ operator> <!-- end AND -->
</[filter>

Put the following interface assertion above the Interfacel nNRouter assertion

‘<interfaceAssertion name="Interfacel nRouter"’

< - - R R T R TR R T R TR R i
HP added this. This identifies interfaces on swouters
that we want to monitor. |Its include Miultilink, Connected, Loopback.
Custoners should nodify this portion to meet their needs. |In particular,
they could renpve or nodify the ifType and ifAlias or add ot her
criteria to the OR condition.
HHHHHHHHHHHH A - - >
<interfaceAssertion name="Interesti ngSwouterl F' title="" description="">
<oper at or oper="OR"'>
<attribute>
<capabi | i t y>i sL2Connect ed</ capabi l i ty>
</attribute>
<l-- iftype 24 = | oopback -->
<l — These two are commented out
<attribute>
<i f Type>24</if Type>
</attribute>
<attribute>
<ifAl'ias>MWAlias*</ifAias>
</attribute>
End of comment -->
</ oper at or >
</interfaceAssertion>

<\ - - #HHHHHBHHHHH B AR R R R R R R R R R R
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HP added this. This identifies interfaces on swouters
BHHHHH BRI R - - >

<interfaceAssertion name="Interfacel nSwouter" title="Interfacel nSwouter"
description="Interface in Swouter">
<oper at or oper ="NOOP" >
<interfaceAssoci ation ascType="i nNode">i sSwout er </ i nt erfaceAssoci ati on>
</ oper at or >
</interfaceAssertion>

validate the change
0o $OV_BI N ovet _t opodunp.ovpl —Ifilt
§ Thiswill giveyou alist of filters and the new one created will be
listed: isSwouter
0o $OV_BI N ovet _topodunp. ovpl —node —filt isSwouter
§ Thiswill list al the swouters in the topology
0 $OV_BI N ovet _topodunp.ovpl —if —filt InterestingSwouterlF
§ Look to seeif this matches the interfaces you marked as
“interesting”
0 $OV_BI N ovet _topodunp.ovpl —if —filt PolledSwouterlF
§ Look to seethat these are interfaces you want to poll
O $OV_BI N ovet _topodunp.ovpl —if —filt NotPol | edSwouterlF

8 Look to see that these are interfaces you do not want
to poll
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paConfig.xml
- Make abackup of thefile
Edit thefile. Not that bolded items are to observe the changes but should not
stay. By setting a value off by 1, you can observe that the settings are taking
affect.
Put the following class specification aka polling policy above the ‘isRouter’ class
specification. Here we are making the class specification for the Swouter nodes.

<cl assSpeci fication>
<filterName>i sSwouter</filterName>
<par anet er Li st >
<par anet er >
<nanme>snnpEnabl e</ name>
<title>Enable polling via SNWP</title>
<descri pti on>
Enabl e/ Di sabl e polling of a device via SNVP
</ descri ption>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t rue</ val ue>
</ var Val ue>
</ par anet er >
<par anet er >
<name>pi ngEnabl e</ name>
<title>Enable polling via |CMP</title>
<descri pti on>
Enabl e/ Di sabl e polling of a device via | CVP
</ descri ption>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t rue</ val ue>
</ var Val ue>
</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>

Put the following polling policies above the
UnconnectedAdminUpOrTestRouter| F class specification. This will

< - - R R T R TR R T R TR R i
Added by HP. To replace the Connect edAdnm nUpSwouter | F
and Unconnect edAdni nUpSwout er I F from previ ous swout er sol ution
IO R TR R R - - >
<cl assSpeci fication>
<filterName>Pol | edSwout er| F</filterName>
<par anet er Li st >
<par anet er >
<nanme>snnpEnabl e</ name>
<title>Enable polling via SNWP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via SNVP. </description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t r ue</ val ue>
</ var Val ue>
</ par anet er >
<par anet er >
<name>pi ngEnabl e</ name>
<title>Enable polling via ICMWP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via | CVP. </description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>t r ue</ val ue>
</ var Val ue>
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</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>

<cl assSpeci fication>
<filterName>Not Pol | edSwout er| F</filter Name>
<par anet er Li st >
<par anet er >
<nanme>snnpEnabl e</ name>
<title>Enable polling via SNWP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via SNVP.</description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>f al se</val ue>
</ var Val ue>
</ par anet er >
<par anet er >
<name>pi ngEnabl e</ name>
<title>Enable polling via ICWP</title>
<descri pti on>Enabl e/ Di sabl e polling of a device via | CVP. </description>
<var Val ue>
<var Type>Bool </ var Type>
<val ue>f al se</val ue>
</ var Val ue>
</ par anet er >
</ par anet er Li st >
</ cl assSpeci fi cati on>

validate the change
o /opt/ OV support/NM checkpollcfg -0 <ip addr of swouter>

§ You should see that unconnected interfaces are not polled

Now restart the poller
o ovstop —c ovet_poll
o ovstart —c ovet_poll

Now restart the APA poller

§ $OV_BI N ovstop —c ovet_pol |

§ $OV_BINovstart —c ovet _poll

§ $OV_BI N ovstatus —c ovet _pol |
Wait until the poller status shows “Polling Devices”
Validate that the swouter polling policy is being used by the interfaces on the
swouter by running ovet_demandpoll.ovpl with the —d option. Most, but not
necessarily all, of the interfaces will have swouter polling policies. “Admin

Down” interfaces tend to be picked up by other policies.
§ $OV_BI N ovet _demandpol | . ovpl —d <swouter >

| NTERFACE nmyswouter.hp.conf O [ 48 ] ]

OBJ_TYPE SHORT_OBJECT_NAME snnpEnabl e ET_FI LTER

all -types * true DEFAULT

NODE myswout er true i sSwout er

| NTERFACE myswout er [ 0] 48] ] true Pol | edSwout er | F
Conposi te nyswout er[0[ 48] ] true NodeVal && InterfaceVa
OBJ_TYPE SHORT_OBJECT_NAME pi ngEnabl e ET_FI LTER

all -types * true DEFAULT

NODE myswout er true i sSwout er

| NTERFACE myswout er [ 0] 48] ] true Pol | edSwout er | F
Conposi te nyswouter[0[ 48] ] true NodeVal && InterfaceVa
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Now re-run the ovet_demandpoll without the —d option to actually poll the nodes.
When you used the —d option before, it doesn’t actually poll the node but instead
just gives debug information. If you affected a change on many swouters, then
you must either ovet_demandpoll all of them or wait 24 hours for the poller to
“config check” them.

Last, go back and add other interfaces you would like to poll in the
InterestingSwouter| F filter.
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